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DISCOVER
ASTON UNIVERSITY
5 STAR RATED
Aston University has been awarded five star
status by global education ranking specialists
QS. The five star rating recognises excellence
in teaching, employability, innovation, facilities,
inclusiveness, and internationalisation.

Teaching

You will be taught by both
academic experts and practitioners
who bring a wealth of real world
experience into the classroom.
There is an emphasis on learning
by doing, to ensure that you gain
practical experience by applying
theory to real life contexts. In 2017
Aston University was awarded
Gold status in the Teaching
Excellence Framework (TEF).

Employability

Studying industry-relevant
courses as part of an international
student body means you can
develop the knowledge and skills
demanded by global and local
employers. You have access to
high quality and personalised
careers advice and guidance, and
more than 200 employers who
come onto campus every year.

Innovation

Aston has been at the forefront of
innovation for many years, having
pioneered the undergraduate
placement year. We have
integrated work experience and
professional skills development
into many of our postgraduate
programmes. If you would like
to start your own business you
can access our intensive start-up
support programme for student
and graduate entrepreneurs.
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Facilities

Our modern facilities include our
Library open seven days a week,
lecture theatres, classrooms
and labs. The Hub is our one
stop student support centre. We
have extensive IT facilities, many
with 24 hour access, and Wi-Fi
available across campus.

Inclusiveness

A diverse group of students from
over 130 different countries live
and study on our green and fully
accessible campus, which is
at the heart of Birmingham city
centre. We offer a wide range
of scholarships to enable the
brightest and the best to study
with us.

Internationalisation

You will have the opportunity
to gain international experience
by undertaking a period of
study abroad or an overseas
exchange. We have over 100
different partner universities in 40
different countries.

7

DISCOVER
OUR CREDENTIALS
Founded in 1895 and a University since
1966, Aston is a long established researchled University known for its world-class
teaching quality and strong links to
industry, government and commerce.
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Top

%

Aston Business
School is among
the top 1% of
business schools
worldwide with triple
accreditation

Top

20

Top 20 in the
UK for Student
Experience
(The Times and Sunday Times
Good University Guide 2018)

17

th
in the UK

17th in the UK and
44th in World for
International Outlook
(Times Higher World Rankings 2018)

School of Engineering
and Applied Science
Our MSc Engineering
Management is ranked 2nd in
the UK and 5th in Europe by
Eduniversal European Rankings
2018.
We hold the Athena Swann
Silver Award in recognition of
advancement and promotion of
gender equality in SET subjects.
We deliver two unique two-year
Erasmus Mundus Joint Master
Degree programmes in photonics
and 5G wireless technologies
and photonic integration for
communication, sensing and
switching.

Aston Business School
Among the top 1% of business
schools worldwide with triple
accreditation from AMBA, AACSB
and EQUIS.
We were one of the first UK
business schools to be awarded
the Small Business Charter in
recognition of our ongoing work
to support small businesses,
the local economy and student
entrepreneurship.
Our Masters degrees provide
students with an opportunity to
undertake an internship or period
of study abroad.
Our MSc Investment Analysis is
ranked in the global top 60 by
the FT Masters in Finance 2018.
Students learn by doing in our
dedicated Reuters Trading Room.

School of Life and Health
Sciences
Aston University’s School
of Pharmacy was honoured
with a Regius Professorship
- one of just 12 universities
with reputations for research
excellence to receive the
prestigious award as part of
celebrations for HM the Queen’s
90th birthday in 2017.

Aston Medical School
Aston Medical School opened for
postgraduate research students
in October 2015 with the first
MBChB undergraduate cohort
starting in September 2018.

School of Languages and
Social Sciences
One of only two universities in the
UK to offer a Masters in Forensic
Linguistics.
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DISCOVER
OUR UK LOCATION
Birmingham International Airport
is a 10-minute train journey to M6 (J6)
and from the city centre.
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Our campus
1	Aston University Main
Building and reception
2	Aston Business School
3 Library
4 Students’ Union
5 Aston Brain Centre
6 Vision Sciences
7 Aston Medical School
8	Sir Doug Ellis Woodcock
Sports Centre and pool
9	Martin Luther King MultiFaith Centre

14 Sack of Potatoes pub
15 Gosta Green pub
16	Aston University nursery
and pre-school
Student accommodation

10	Five-a-side sports pitch
11 Sports pitch
12	European Bioenergy
Research Institute (EBRI)
13 Shops on campus
- Tesco Express
- Costa Coffee
- Ryman Stationery
- Greggs
- Wok & Go
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With our campus based in the cosmopolitan
city centre of Birmingham it’s just a 10 minute
walk to reach all the facilities you would expect
in a modern city such as excellent rail, bus and
metro links, world class shopping centres and
entertainment venues. As the UK’s second largest
city, Birmingham is culturally diverse and rich in
history, so you will be sure to find something to
suit your tastes and interests.
	Being at the centre of the UK means travelling to and
from Birmingham is easy. Our international airport
serves over 100 direct routes, our motorway system
links us to the north and south of the country with
ease and we have three train stations in the city centre
including Birmingham New Street from which you can
travel to London in less than 90 minutes.
	From street food at the award winning Digbeth Dining
Club to fine dining at Michelin starred restaurants,
and cuisine from across the globe, Birmingham is fast
becoming a food tourist hotspot.
	You’ll find everything you need from high-street chains,
designer shops, independent and vintage boutiques,
as well as a large variety of food stores, markets and
international grocers.
	There’s a wide range of museums, galleries and
heritage sites to enjoy all year round.
	Over 8,000 acres of parks and open spaces offer
plenty of places to relax or play sport outdoors.
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Aston University is proud
to be the Official UK
University Partner of Aston
Villa Football Club
City locations shown opposite
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3
4
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Digbeth street art
Grand Central
Bullring shopping centre
Brindley Place
Town Hall Birmingham
Library of Birmingham
The Mailbox shopping centre
Birmingham city centre
Chinese quarter
Cadbury World
Edgbaston cricket ground
Birmingham canal network
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DISCOVER
OUR CAMPUS
As an Aston student you get the best of both
worlds: a green, well-equipped, friendly
campus in the centre of a vibrant city. With
our entire social, support and academic
facilities based on campus you’ll never have
far to go.
With modern on campus accommodation and the
city of Birmingham on your doorstep there are a
wide range of housing options to suit all tastes and
budgets.
Campus facilities include:
	Library: open seven days a week, (24 hour
opening during exam periods)
	Health and welfare services including dental,
optician and counselling services
	The Martin Luther King multi-faith centre
	24 hour on-site security
	Sports centre with sports halls, a 110-station
gym and swimming pool
	Extensive IT facilities, some with 24 hour access
	General store, bookshop, computer shop,
supermarket and 24 hour cash points
	Wifi internet access available across campus.
Those studying via distance learning will have access
to our Virtual Learning Environment, extensive digital
library catalogue and study support via email, phone
and Skype*.
*Communication channels vary for individual services
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DISCOVER
OUR ACCOMMODATION

Accommodation is on
Aston’s city centre campus
and everything is within
walking distance.

Facilities
Bedroom complete
with study space
All utility bills included
Free high speed
internet
Ensuite shower
facilities
Onsite safety
Laundry

Rooms on campus have either
been built within the last four
years, or have recently been
refurbished. All accommodation
is ensuite and has access to
high speed internet.
We guarantee a room offer
to all international applicants
who accept their offer and
pay their deposit before the
accommodation deadline.
Details of the accommodation
offer and deadline will be
available in your offer letter and
on our website.
For further information, including
rents, see:

aston.ac.uk/accommodation

2nd

in the UK
for student
accommodation
2017 University Compare Rankings
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DISCOVER
YOUR CAREER
Amrit Grewal
Course

MSc Communication Systems and
Wireless Networking

Destination

Associate Engineer
Rolls Royce

You will have opportunities to develop skills
and experiences to match your career
ambitions. Studying industry-relevant courses
as part of an international student body means
you can develop the knowledge and skills
demanded by global and local employers.

High quality careers guidance, education
and information services are delivered
through individual appointments, group
sessions and online tutorials. We bring
students and employers together for oncampus employer presentations, interviews
and recruitment fairs.

Aston has strong industrial links and
this was particularly attractive to gain
real experience whilst simultaneously
studying. Another aspect that Aston
provided was the guest lectures and
events which we were encouraged to
attend and participate in. I felt these
were invaluable as they introduced real
world problems and developments
occurring within my field.”

Over 200 employers come
onto campus each year to
meet our students, including….
3M // Accenture // Aldi // Armed Forces // AXA // BAE Systems //
Balfour Beatty // Barclays // Bentley // BMW // Boots // BT //
Capgemini // Caterpillar // Co-op // Corus // Deloitte // E.ON //
Ernst & Young // ExonMobil // Fujitsu // GlaxoSmithKline //
Harrods // HP // HM Revenue and Customs // HSBC // IBM //
Intel // Jaguar Land Rover // Mondelez // KPMG // L’Oreal //
Lloyds Banking Group // Marks & Spencer // Microsoft // Morgan
Stanley // NHS // PriceWaterhouseCoopers // P&G // Rolls-Royce //
Sainsbury’s // Santander // Tesco // Unilever // Vision Express
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WELCOMING
INTERNATIONAL
STUDENTS
Aston has long been a popular destination for international
students. You will learn in a friendly and diverse community
in the centre of Birmingham, a vibrant and multicultural city.
Birmingham has a rich international heritage and we welcome
people from all countries to be part of our city.

Birmingham is home to 187 different nationalities
and celebrates a wide range of major festivals from
Vaisakhi to Eid to Chinese New Year. Aston is a
welcoming and safe place to live and study, and we
are proud that our university is open to students
from around the world.

Campus community

Accommodation

Welfare and support

Aston has a diverse student
population of over 10,000
full-time students from over
130 countries. Most of our
international students choose
to live on campus so that
they can benefit from living
and studying in a campus
environment right in the city
centre of Birmingham.

Accommodation on campus
means easy access to facilities
and no travel costs. All rooms
are single occupancy, ensuite
and self-catering. We are
sensitive to individual student
needs and our Residence
Tutors will support you if you
need any help.

The University’s extensive
welfare and support services
for all students are accessible
through The Hub, which is
centrally located in the front of
our main building. From here
you can access the following
support services:

There are a number of
international student societies
at Aston, including the African
Caribbean Society, Asian
Society, Sikh Society, Chinese
Student Scholar Association
and the Hong Kong Society.

We guarantee a room offer
to all international applicants
who accept their offer and
pay their deposit before the
accommodation deadline.
Details of the accommodation
offer and deadline will be
available in your offer letter and
on our website.

Advice Zone
Counselling Service
Disability Team
	International Student
Advisers (for free advice on
a range of issues including
immigration and visa
renewal).
Additional support is also
offered via:
	
Students’ Union Advice
and Representation
	
Martin Luther King MultiFaith Centre

20
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WELCOMING
INTERNATIONAL STUDENTS
English language entry
requirements
To be accepted onto our
programmes, you must be
able to satisfy the University’s
English language requirements.
The level required will depend
on the programme you are
applying for.
We strive to make your
application process as easy
as possible, however in all
cases we reserve the right to
request an English language
qualification and / or conduct
an interview.
Pre-sessional Programmes
in English for Academic
Purposes
For applicants whose English
falls short of our minimum entry
requirements we provide a
range of pre-sessional English
Language programmes which

22

aim to enable our applicants
to reach our required levels
of English and help them to
become more confident about
studying in English in the UK.
You can gain the relevant
language and academic skills
necessary for success on your
future course by attending one
of our pre-sessional English
courses. The length of course
required will be detailed in your
offer letter.
30, 18, 12, 6 and 4 week
programmes are available
before the beginning of your
course.
During your pre-sessional
programme you will focus on:
	developing your academic
writing skills

	expressing your ideas
and opinions in seminar
discussions
	developing your
presentation skills
	improving your
pronunciation of English
	developing your
grammatical accuracy and
range of structures
	extending your general,
academic and subjectspecific vocabulary
	developing your research
skills
For more information on
our pre-sessional English
programme please visit our
website.

Aston Welcome Week
Aston University holds an
International Orientation Week,
followed by a Freshers’ Week
for all new students, designed
to help you settle in and adjust
to student life.
Second and final year students
called ‘Aston Aunties’ will help
you throughout these two
weeks. The Aunties provide a
friendly face and help guide
you around campus, show
you the sights and answer any
questions.
Welcome Week will also:
	Help you adapt to a new
culture, language, food,
the British climate and
your surroundings at Aston
University

	practising effective reading
strategies

	Introduce you to the
University and its services

	understanding academic
lectures and taking notes

	Help you meet other
international students

	Assist you with practical
arrangements such as
shopping for food and
other necessities such as
opening a bank account
	Introduce you to the
services provided by the
Students’ Union including
clubs and societies,
student sports clubs and
sports provision

Scholarships
Aston offers a large number
of scholarships to support
academically talented
international students. If
you meet our criteria you
will be encouraged to apply
for a scholarship. If you are
offered a scholarship you
must accept your place to
secure your award.

	Introduce you to the
academic system at Aston
University, study methods
and approaches to
learning
	Introduce you to cross
cultural communication
and basic presentation
skills through workshops
and group interaction.

23

Aston
Business
School

For full details of entry
requirements for each
course please visit the
course page on our website:
www.aston.ac.uk/abs

Aston Business School is
among Europe’s largest
business schools, with
approximately 3,000
students. It has been
conducting pioneering
research into modern
business and management
issues for over 60 years,
making it one of the longest
established, research-based
business schools in the UK.

Our postgraduate portfolio
has been designed in close
partnership with business
and industry, giving you an
ideal platform from which to
build your future career. Our
course structures enable you
to gain the skillsets needed to
succeed in today’s competitive
workplace, such as negotiation,
communication, leadership,
teamwork and innovative thinking.
It is skills such as these that keep
our graduates highly sought after
by some of the world’s leading
organisations.

Aston Business School is one of
just 1% of business schools in
the world to hold AACSB, EQUIS
and AMBA accreditations - three
of the most recognised and
prestigious accreditation bodies
in the world.

To put these skills into practice
we believe that our students
deserve the very best of
opportunities to experience the
real business environment, with
live projects and internships to
prepare you for the real world.
Aston Law School is part of Aston
Business School. We are proud
to launch for 2019 our new LLM
International Commercial Law
programme. See page 37 for
details.

24

Aston Business School
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+44 (0)121 204 4910

E

ask@aston.ac.uk
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www.aston.ac.uk/abs

Professional Development
Programme
The Professional Development
Programme (PDP) is an integrated
module which runs throughout
all MSc programmes at Aston
Business School. Focusing on
professional development and
employability, this module gives
you the opportunity to identify,
develop and apply the key skills
you will gain throughout the
year. As you work through this
compulsory module you will:
Build a skills portfolio which

allows you to showcase
the competencies you have
acquired during your studies,
competencies that are highly
desirable to employers
worldwide

	
Take part in a range of skills

workshops and simulations

	
Have the opportunity to

complete an integrated work
internship of up to 12 months
or complete a study abroad
opportunity with one of over
50 international partner
institutions worldwide. Aston
University participates in the
Erasmus Programme which
provides opportunities for
students to apply for funding
to support work and study
abroad.

Aston Business School
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Executive DBA

PhD

Programme overview

Programme overview

The Aston AMBA-accredited Executive DBA is the
highest level of business qualification available. It
offers a distinctive opportunity to work with worldleading academics to advance research to continually
progress thought on how to develop effective
organisations. To succeed, participants must show
that they can transform practice with the knowledge
they have created. Participants discover how to turn
complex ideas into actions and become recognised
as thought leaders in their field.

DBA topics and supervision

Study abroad opportunities

Partner institutions include:

We have long-established
partnership agreements with
many business and management
schools across the world, who
offer the same high standards
of teaching quality. These
agreements provide you with
the option to spend some of
your study time with one of our
partner institutions to gain further
academic credentials in addition
to your Aston degree course.

	
BI Norwegian Business

You can study during Term 3,
at a Summer School, during the
Autumn Semester.

	
National Chengchi University,

All programmes are taught in
English and are tuition-free: they
are based on reciprocal exchange
agreements and although you will
need to take care of your travel
and living expenses, you will not
need to pay any tuition fees to the
partner institutions.

School, Oslo

	Católica Porto Business School,
Lisbon
	The Chinese University of

Hong Kong

	
KEDGE Business School,

Bordeaux, Marseille, Paris

	
Korea University Business

School, Seoul
Taiwan

	
N
 anyang Technological

University, Singapore

	
Q ueensland University of

Technology, Brisbane

	
University of Florida,

Gainesville

	
University of Mannheim
	The University of Sao Paulo,
Brazil
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Aston Business School

When you apply for a DBA you will need to have
an idea of the kind of research project you’d like to
embark upon. With your application, you will need
to submit a research proposal to demonstrate how
you plan to take your topic further. Your supervisor
will have an excellent research track record directly
related to your DBA topic. This is a rare facility that
can only be undertaken by an institution with our
research breadth. We will only take you on as a DBA
if you can be supervised by a member of the School
who is a world-class researcher in their chosen field.

Programme structure

The Executive DBA is a part-time distance learning
course which can be completed in four years. Actual
completion may vary depending on circumstances.
>	Year 1 (up to two maximum): Research Methods
Course and Qualifying Report
>	Years 2-4 (up to six years maximum): Individual
research project and submission of thesis/
portfolio
Additional entry requirements

For direct enrolment onto the Executive DBA
you must have: an MBA, MSc or an MA degree
in business or management (or an equivalent
professional qualification) and a minimum of five
years’ experience in a senior role. Additionally,
you should demonstrate appropriate links to
the practice that your proposed research refers
to. There are additional entry requirements for
students whose first language is not English.

Our PhD programme is designed to train Doctoral
students who aspire to become future academics or
professional industry researchers.

Research strengths

Our research strengths are embedded in our
academic departments:
>	Accounting
>	Economics, Finance and Entrepreneurship
>	Law
>	Marketing and Strategy
>	Operations and Information Management
>	Work and Organisational Psychology
You are strongly recommended to explore these
Academic Department web pages before applying.
Please also visit our PhD web pages for any potential
PhD funding opportunities.

Programme content (including any
research methods courses)

In year one you will undertake four ESRC approved
taught Research Methods modules designed to
provide you with the necessary skills to successfully
complete your PhD and to develop as a well-rounded
researcher. In year 2 you will typically concentrate on
obtaining ethical approval for your research, before
focusing on data collection and analysis. Year 3 is
typically a writing up year, where you will spend most
of your time developing your thesis.

Research environment

We have an exciting and vibrant research environment
that enables you to engage in various research events
and seminars. There is also a dedicated research
society which organises social and academic events.
Academic departments also run research seminars
where students are encouraged to present their
research and get feedback from colleagues. In
addition, our Summer School in Advanced Research
Methods offers additional training opportunities.
Additional entry requirements

Undergraduate degree - 2:1 or above
Postgraduate degree - 65% in both taught and
dissertation elements. Two academic references.
TOEFL - 101 (Reading 23, Writing 28, Listening
23, Speaking 23). IELTS - 6.5 (Reading and
Writing 6.5, Listening and Speaking 6.0).

Aston Business School
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The Aston MBA
The Aston MBA is an extensive programme which immerses you into the principles of strategic thinking
in a business context and prepares you for a career at the forefront of business.
Select from one of Aston’s five MBA programmes to suit your professional commitments. You’ll
experience a dynamic, real-life, learning development experience, allowing you to accelerate your
career with a positive, dynamic, and forward-thinking strategic mindset.
Mode

Duration

Attendance

Start date

Full Time

12 months

On campus

September

Executive
30 months
		

Online study combined with intensive
study weekends on campus

September, January,
April, July

Executive
30 months
Apprenticeship*		

Online study combined with intensive
study weekends on campus

September, January,
April, July

Online
24 months
100% Online
			

September, November, 		
January, March, May, July

* There are currently two Executive Apprenticeship options:
> The Executive Apprenticeship MBA
> The Executive Apprenticeship Management of Manufacturing MBA

Entry requirements

To be eligible to study the Aston MBA (all routes), you will
need:
>	A good UK honours degree
>	An equivalent overseas degree recognised by Aston
University
>	A degree-level professional qualification
>	At least three years’ relevant work experience postgraduation
We accept applications from candidates with extensive
work experience who have not completed a graduate
qualification. You will initially be enrolled as a Certificate
student and attend all the same classes as MBA students.
Provided you pass your first six modules, you will transfer
to the MBA at no additional cost. There are additional
entry requirements for international students. Please
see our website www.aston.ac.uk/mba for full entry
requirements.

Join the ranks

Aston Business School is consistently recognised by the
world’s most prominent rankings as being at the forefront
of business education:
>	Triple accredited - Aston is part of an elite group of
Business Schools worldwide with triple accreditation
from AMBA, AACSB and EQUIS.
>	The Aston MBA is one of the world’s top MBAs (Tier 1)
in CEO Magazine Global MBA Ranking 2018.
>	Our Online MBA is ranked in the top 10 in the world
by CEO Magazine and top 20 in the world by QS
Distance Online MBA Rankings 2018.

The Aston Edge

The Aston Edge is a personal leadership development
programme which runs throughout the MBA core
curriculum to develop your professional skills to help you
to become a better performer, achieve your goals, and
equip you with the skills to respond to the big challenges
that lie ahead in your future.
You will develop key skills such as negotiating, managing
staff expertise, acting with confidence, to lead, inspire and
influence. You’ll develop a leadership and entrepreneurial
mindset in everything you do.

Aston is part of an
elite group of Business
Schools worldwide with
triple accreditation from
AACSB, EQUIS and AMBA

The Aston Edge is delivered through a series of dynamic,
engaging leadership workshops and seminars with high
profile key speakers and guests to drive your strategic
thinking and respond to real world business challenges.
For more information visit www.aston.ac.uk/mba

More than an MBA

>	
Business principles into practice: You will learn
by putting business principles into practice, solving
real-world business challenges. You will engage in live
consultancy projects, engaging with high level brands,
workshops, speaker sessions, and live projects. Your
final module is a flexible self-directed activity which you
will negotiate with your programme director.
>	
Assessment: You will be assessed by simulated and
live project activity as you demonstrate your innovative
and strategic thinking. Your final module is a flexible
module with a key leadership focus, negotiated by you.
> The Aston Edge: You will develop key professional
development skills through The Aston Edge, our
personal leadership development programme which
runs throughout the MBA.
>	
Networking: A range of events and activities will
enable you to grow your networks to build professional
business relationships.
Mentor support: To support your learning you will
>	
have the opportunity to be partnered with an Aston
MBA graduate mentor for study support – a key
sounding board for your studies.
>	
Career support: Receive comprehensive career
management support from Aston’s dedicated MBA
careers consultant.
Core content
>	Strategic management
>	Leadership
>	Marketing
>	Accounting
>	Operations Management
>	Entrepreneurship

Basel Hammoda
Course

Full Time MBA

Destination

Techology Manager at Capgemini

Aston shaped my personal and
professional profile. Thanks to the
connections of the Business School I was
invited to the House of Lords to consult
on a draft agenda while I was studying.
The Aston MBA has many merits. To
name a few, the cultural diversity was
amazing, the dedicated study areas, the
hundreds of real-life case studies
we worked on and the very
friendly and approachable
academic staff, which you
will never find anywhere
else in the UK.”

Optional content
>	E-business Strategy
>	International Business
>	International Finance
>	International Marketing
Management
>	Advanced Strategy

Your final module is a professional flexible module with a
leadership focus – self-defined and negotiated by you.
28

Aston Business School

Aston Business School
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MSc Accounting and
Finance
Programme overview

Designed for graduates from any discipline, this
programme provides a solid understanding of
accounting and finance principles and their joint
role. You will learn how organisations use financial
information for decision-making, performance
evaluation and financial reporting purposes in different
contexts including businesses and public sector
organisations.

Core modules

> Financial Accounting and Reporting
> Management Accounting
> Contemporary Issues in Financial Reporting
> Strategic Management Accounting
> Sustainability Accounting and Accountability
> Business Finance
> Financial Analysis
> Ethics in Academic Practice
> Professional Development Programme (PDP)
> MSc A&F Project or MSc A&F Dissertation

Elective modules

>	Fundamentals of Audit and Taxation
>	Islamic Accounting and Finance
>	Corporate Governance, Regulation and
Compliance
>	International Finance
>	Research Design, Practice and Ethics

Professional accreditation

MSc in Accounting and Finance is accredited by
the Association of Chartered Certified Accountants
(ACCA) and the Chartered Institute of Management
Accountants (CIMA). Successful completion of this
course leads to exemptions from these professional
accounting bodies. You will still need to secure
professional training and complete further exams in
order to become fully qualified in accountancy, but
these exemptions demonstrate to future employers
your commitment and potential to complete sector
qualifications.
Why choose this course?

MSc Business Analytics
Programme overview

MSc Business Economics
and Finance

Modern businesses in the UK and worldwide have a
great need for professionals with analytical planning
and big data analysis skills. This course will equip you
with the quantitative skills needed to understand and
engage with complex data, as well as the analytical
tools to drive business advantage. You will deepen
your knowledge of business analytics, web analytics,
data mining and management.

Programme overview

Core modules

Core modules

>	Descriptive Analytics
>	Effective Management Consultancy
>	Decision Models
>	Performance Analytics
>	Data Mining and Web Analytics
>	Software Analytics
>	Ethics in Academic Practice

Elective modules

>	Business Analytics in Practice
>	Digital Marketing
>	Financial Econometrics
>	Big Data for Decision Making
>	Advanced Spreadsheets and Databases
>	Simulation for Managerial Decision Making
>	Services Innovation
>	Business and Risk Context
Why choose this course?

There is a high employer demand for
graduates of this course. You will improve your
employability potential by gaining the expertise
needed to analyse big data, improve decisionmaking and help companies gain a competitive
advantage.

Additional entry requirements

You must be able to demonstrate strong
quantitative skills.

Career prospects

This course will prepare you for a range of
specialist careers in data analytics, such as a
consultant, data analyst, manager or business
analyst.

You will gain detailed knowledge of economics
and finance subjects and develop familiarity with
key theories that aid in understanding real world
issues. You will gain a wide range of practical and
transferable skills, including quantitative methods,
which are in high demand by employers.
>	Advanced Quantitative Methods
>	Economics of Governance and Organisations
>	International Finance
>	Macroeconomics
>	Quantitative Methods for Finance
>	Ethics in Academic Practice
>	Professional Development Programme (PDP)
> MSc Dissertation

Elective modules

>	Entrepreneurial Strategies
>	Entrepreneurship and Innovation in Emerging
Economies
>	International Business
> Investment Banking
>	Strategic Management
>	Valuation of Investments
>	Business Finance
Why choose this course?

You will learn from leading academics who are at
the forefront of their research area and regularly
interact with policymakers and businesses to
advise them on key decision making matters.

Additional entry requirements

Some fundamental knowledge of economics
(successfully completed 10 ECTS credits, the
equivalent of two standard undergraduate
modules).

Career prospects

This course will prepare you for a career in the
financial sector, for example as an economic or
financial analyst.

MSc Business and
Management
Online also available

Programme overview

You’ll acquire the business skills sought after by
graduate employers worldwide, including interpreting
financial statements, developing marketing and
pricing strategies and understanding strategy and
innovation processes. This course is suitable for
graduates of all disciplines, giving you a broad
knowledge of business management.

Core modules

>	Accounting for Non-Financial Managers
>	Applied Research Methods
>	Marketing Management
>	Strategic Management
>	People and World Organisations
>	Operations Management
>	Professional Development Programme
>	Ethics in Academic Practice
>	Professional Development Programme (PDP)

Elective modules

You will choose a particular pathway from a number
of options including International Business, Finance,
Governance, Marketing and Organisational Behaviour.
Why choose this course?

Optional modules enable you to tailor the course
to shape your needs. The skills you gain on a
business and management masters will allow
you to start contributing to your employer’s
organisation immediately.

Career prospects

Our graduates have secured employment in a
wide range of roles such as Brand Activation
Executives; Communications and Training
Executives; Management Consultants and
Senior Business Analysts. This has involved
working for organisations including Unilever
(United Arab Emirates); Tesco (UK); Deloitte
(India) and Lloyds TSB (UK.).

Employment prospects are good and with
global markets continuing to be in financial
turmoil organisations need to be able to report
accurately, analyse and understand the financial
situation at all times.

Career prospects

Our graduates have secured employment in
a wider range of roles such as Accountants,
Analysts and Risk Consultants. This has involved
working for organisations including EY (China);
Deutsche Bank (London) and KPMG (Russia
and CIS).
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MSc Business Psychology

MSc Entrepreneurship

Programme overview

Programme overview

This course is an ideal introduction to human
behaviour in the workplace. Gain an understanding
of what makes individuals thrive at work, learn how
to improve organisational performance, and how to
make the workplace a happier environment.

Core modules

>	
Organisation Behaviour: Theory and Practice
>	
Learning and Talent Development
>	
Assessment, Performance and Reward
>	
Organisational Behaviour
Strategy, Change and Leadership
>	
>	
Research Methods
>	
Dissertation
>	
Professional Development Programme (PDP)

Elective modules

Choose two:
Employee Relations in Context
>	
>	
Careers and Counselling
>	
Employee Relations and Counselling
>	
Strategic and International Human Resource
Management
>	
Marketing Management
>	
Operations Management
>	
Strategic Management
>	
Management of Innovation
>	Economic Environment of Business

Professional accreditation

MSc Business Psychology is accredited by the
Association for Business Psychology and students
on this course are eligible for student membership
while they study. The programme is NOT accredited
by the BPS and graduates would not be eligible
for registration with the HCPC as a practitioner
psychologist.
Why choose this course?

Develop a career either as a general manager
or as an organisational consultant, or take a first
step towards an academic or research-based
career.

Additional Entry Requirements

Applicants should ideally have an undergraduate
degree which contains psychology, social
sciences or business related subjects.

Career prospects

Our graduates have secured employment in a
wide range of roles such as Administrative and
Diplomatic Officers, Business Development
Managers, Human Resource Advisors and
Human Resource Partners. This has involved
working for organisations including the Ministry
of Human Resources (Malaysia), Prodos Ltd
(Nigeria), Transport for London (UK) and Ford
Motor Company.
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Learn to think like an entrepreneur, and develop an
understanding of the global business environment.
Enterprise skills are highly valuable outside of new
venture start-ups, as employers are increasingly
looking to hire employees with an entrepreneurial
mindset. You’ll gain analytical and strategic skills to
enable you to set up and manage new enterprises
within a national and international context, and the
knowledge required for developing innovation-based
business strategies.

Core modules

>	
International Entrepreneurship
>	
Business Venturing
>	
Entrepreneurship and Innovation in Emerging
Economies
>	
Ethics in Academic Practice
>	
International Business
>	
Entrepreneurial Strategies
>	
Professional Development Programme (PDP)
MSc Dissertation
>	

Optional modules

>	
Strategic Business Sustainability
>	
International Marketing Management
>	
Strategic Global Outsourcing and Offshoring
>	
Operations Management
Strategic Management
>	
>	
Management Consulting
>	
Intellectual Property Strategy and Management
>	
Business Finance
>	
Accounting for Non-financial Managers
>	
People and World Organisations
>	
Marketing Management
>	
Management of Innovation
>	
Economic Environment of Business
Why choose this course?

Get consultancy experience on a live business
dissertation project. Access BSEEN (Birmingham
Skills for Enterprise and Employability Network):
a business incubator located on campus, offering
tailored business support, workshops and
enterprise events throughout the academic year.

Career prospects

This course will prepare you to be an
entrepreneurial employee in today’s dynamic
corporate environment. Recent graduates
have set up their own businesses in a variety
of sectors including: Marketing, Energy,
Manufacturing and Insurance Services.

MSc Enterprise
Development
Programme overview

This is an innovative, dynamic and flexible part
time course, ideal if you want to develop your
management, entrepreneurship, and innovation skills.
There are no lectures or exams; this programme puts
application and experience at its core. Throughout the
two years you will undertake live business challenges
in a team, putting entrepreneurship and management
principles into practice. You will learn how to generate
ideas, develop new product/service ideas and bring
them to market. Most importantly, you will learn
the importance of building your enterprise around
customer value.

Core modules

>	Enterprise Creation
>	Creating and Leading High Performance Teams
>	Applied Research
>	Innovation and Entrepreneurship
>	Enterprise Management and Growth
>	Leading High Performance Teams
>	Corporate Social Responsibility Challenge
Why choose this course?

If you like learning through application and
practice, this is the course for you. You will
learn how to set up and manage a business by
actually setting up and managing a business.
There will be no exam stress to distract you.
All of your assessment will be authentic
and developmental. You will be assessed
through business/product proposals, personal
reflections, marketing plans and real life market
research, all of which are crucial skills for the
modern professional. The programme is part
time, allowing you the time and flexibility to
structure it around your personal and work
commitments. This is one of the only courses of
its type in the country. It is different – are you?

Career prospects

This programme would be ideal for anyone
wishing to set up their own business or social
enterprise. It also provides an excellent route to
management and leadership.

MSc Finance
Programme overview

This course will develop your knowledge and
understanding of financial markets and how they
impact on decision-making. Studying MSc Finance
at Aston provides you with access to the most
innovative tools available, including a dedicated
trading room facility and market trading simulations,
to give you the experience and confidence you
need to succeed in the finance industry. This course
will develop your knowledge of finance theory with
practical applications and research tools. During
the summer term you will also have the opportunity
to attend a workshop designed to help students
taking the CFA® (Chartered Financial Analyst) Level I
examination.

Core modules
>
>
>
>
>
>
>
>

Advanced Corporate Finance
Derivatives
Fixed Income Securities
Quantitative Methods for Finance
Financial Econometrics
Finance Theory
Trading in Securities Markets
Ethics in Academic Practice

Elective modules

> Trading Techniques
> International Finance
> Investment Banking
Why choose this course?

Our facilities allow you to experience real
life situations with access to a dedicated
Trading Room facility and asset market trading
simulations.

Additional entry requirements

You must demonstrate a good level of
quantitative and analytical skills gained from a
degree in finance or economics (we will also
consider an upper second class degree in
mathematics, statistics, computing, engineering
or the sciences).

Career prospects

Our graduates have secured employment
in a wide range of roles such as Analysts,
Consultants and Investment Risk Officers. This
has involved working for organisations including
Goldman Sachs (UK), EY (France) and BNP
Paribas (Luxembourg).
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MSc Global Operations
and Service Management
Programme overview

This course will provide you with a key knowledge
of advanced operations management at a global
level. You will develop knowledge of the latest global,
economic, environmental and social challenges and
strategic management operations, and become
critically aware of key issues such as sustainability,
globalisation, digitisation, advanced manufacturing
services, and the impact of emerging technologies.
You will learn how to apply theories and techniques
of operations management in diverse socioeconomic contexts, industrial sectors, and cultural
environments.

Core modules

> International Operations Strategy
>	Managing Multi-organisational Enterprises and
Enterprise Systems
>	Managing Projects
>	Management of Innovation
>	Operations Management
>	Applied Research Methods
>	Dissertation

Elective modules

(choose two from optional modules below)
>	Enterprise Resource Planning
>	Big Data
>	Service Operations Management
>	Sustainable Operations Management
>	Industrial Service Innovation
>	Simulation for Managerial Decision Making
Why choose this course?

You will learn from leading academics who are at
the forefront of their research area and regularly
interact with policymakers and businesses to
advise them on key decision making matters.

Career prospects

This course will prepare you for a career in
global operations and service management.

MSc Human Resource
Management
(Full-time and Part-time)

Programme overview

Learn the complex yet subtle art of managing people
in organisations, and develop skills for analysis and
in-depth policy formation as well as the broader
discipline of management. This course is fully
accredited by the largest internationally recognised
HR professional body, the Chartered Institute of
Personnel and Development (CIPD), and will provide
you with the ideal qualification for developing your
career in HR.

Core modules

> Organisational Behaviour
> Strategy, Change and Leadership
> Strategic and International HRM
> Assessment, Performance and Reward
> Learning and Talent Development
> Employee Relations in Context
> Employment Law
>	Research Methods
>	Managing and Interpreting Financial Information
>	Ethics in Academic Practice
>	Professional Development Programme (PDP)

Professional accreditation

This course is fully accredited by the Chartered
Institute of Personnel and Development (CIPD).
Why choose this course?

This course enables you to gain Associate
membership of the CIPD after successfully
completing the course. If there is sufficient
demand from students you may also be offered
a chance to undertake Occupational Test User
(OTU) training and gain a certificate which
is an accredited qualification by the British
Psychological Society (BPS) in psychological
testing. There will, however, be an additional
cost for this qualification.

Career prospects

Our graduates have secured employment in
a wide range of roles such as HR Executives,
HR Assistant Managers, Regional HR Business
Partners and Personnel Managers. This has
involved working for organisations including
KPMG (India), Lloyds Banking Group (UK),
Amazon Logistics (UK) and Tesco (UK).

MSc Information Systems
and Business Analysis
Programme overview

Ranked 3rd in the UK by Eduniversal Best Masters
2017 this specialist course prepares you for a range
of careers in information systems consultancy,
business analysis and management. You’ll gain the
technical skills to develop and manage systems
alongside a practical understanding of project
management and consultancy.

Core modules

>	Advanced Spreadsheets and Databases
> Foundation in Business Systems
> Developing Business Systems Workshop
> Managing Projects
> Learning, Skills and Career Development
> Applied Research Methods
> Ethics in Academic Practice
>	Professional Development Programme (PDP)

Elective modules

>	Data Mining and Business Intelligence
>	Simulation for Managerial Decision Making
>	Enterprise Resource Planning
>	Operations Management
>	Strategic Global Outsourcing and Offshoring

MSc International
Accounting and Finance
Online also available

Programme overview

You will learn how to critically understand accounting within
international business. You will build on the accounting
and finance knowledge gained during your undergraduate
degree to take on a senior management role within a
global organisation. You will focus on the application
of knowledge to real world situations. This course
has a strong international orientation and includes the
opportunity to work abroad as part of your degree.

Core modules

> International Business Finance
> Strategic Management Accounting
> International Business
>	Sustainability Accounting and Accountability
>	International Context of Corporate Reporting
>	International Taxation and Accounting
>	Ethics in Academic Practice
>	Professional Development Programme (PDP)
>	MSc Project or Dissertation

Optional modules

Information systems are the foundation of
business and their operations and this course
will give you the technical, organisational and
people skills that international employers want
across a range of sectors.

>	Current Issues in Global Audit and Assurance
>	Risk Management
>	Islamic Accounting and Finance
>	Corporate Governance, Regulation and Compliance
>	Strategic Global Outsourcing and Offshoring
>	Entrepreneurship and Innovation in Emerging Economies
>	Data Mining and Business Intelligence
> International Business Strategy
> Performance Audit
> Research Design, Practice and Ethics

Career prospects

Professional accreditation

Why choose this course?

This course will prepare you for a range of
specialist careers in consultancy, management
and business analysis, and is also a suitable
first step if you want to pursue a research or
academic career. Our graduates have secured
employment in a wide range of roles such
as Business Analysts, Information Systems
Graduate Trainees and Junior Consultants. This
has involved working for organisations including
Scope International (India), British Gas and
Roland Berger (Nigeria).

This course is a fantastic step towards becoming a
qualified accountant. Several modules are accredited by
the Association of Chartered Certified Accountants (ACCA)
and the Chartered Institute of Management Accountants
(CIMA). This means you will benefit from exemptions, which
reduces the amount of ACCA or CIMA professional training
and exams you’ll need to take to become a fully qualified
accountant once in employment.
Why choose this course?

This course will enhance your global career
prospects and provide you with an advanced
knowledge of accounting and finance.

Additional entry requirements

First degree in Accounting, Finance or relevant subject.

Career prospects

Our graduates have secured employment in
a wide range of roles such as Tax Associates,
Trainee Accountants and Accounting Analysts. For
organisations including Pricewaterhouse Coopers,
Capitax Financial Ltd and IBM.
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MSc International
Business

International Pre-Masters

MSc Investment Analysis

Programme overview

Programme overview

Programme overview

This course is for international students who want
to accomplish a postgraduate degree at Aston
Business School and gain foundational knowledge
of international business. Successful completion of
this course allows you to apply to study any Aston
Masters programmes. The course programme
includes a range of modules to improve academic
English as well as providing a base knowledge of
key concepts and theories of strategic management.
Students will also develop intercultural awareness and
competence within culturally diverse contexts.

Today’s business professionals operate in a global
marketplace with organisations needing to learn
important cultural differences if they are going to
succeed across international borders. This course
will give you cultural awareness and problem solving
skills. The wide range of elective modules will enable
you to develop skills in a specific business function
linked to international business or pursue related
areas such as entrepreneurship and business
sustainability.

Core modules

>	International Business
>	Advanced Topics in International Business
>	Strategic Management
>	Economic Environment of Business
>	Ethics in Academic Practice
>	Professional Development Programme (PDP)
> MSc Dissertation

Elective modules

Choose four modules (subject to pre-requisites and
restrictions on some combinations):
>	Intellectual Property Strategy and Management
>	Business Finance
>	International Finance
>	Accounting for Non-Financial Managers
>	Strategic Business Sustainability
>	People and World Organisations
>	Marketing Management
>	International Marketing Management
>	Strategic Global Outsourcing and Offshoring
>	Operations Management
>	CSR, Sustainable Development and Public Policy
>	Entrepreneurial Strategies
>	International Business Strategy
>	Entrepreneurial and Innovation in Emerging
Economies
Why choose this course?

Ranked 3rd in the UK in the Eduniversal Best
Masters Ranking 2017 and 7th in the UK by The
Economist’s Masters Ranking in 2017

Career prospects

Our graduates have secured employment
as Assistant Advisors, Marketing Specialists,
Relationship Marketing Professionals and Senior
Analysts. Employers include Ernst & Young, Bosch
(China), IBM (India) and Deutsche Bank (UK).

Core modules

The programme is broken down into two types of
award, the Graduate Diploma and the Graduate
Certificate. The Diploma runs across three terms (one
academic year) and the Certificate runs across two
terms (6 months).

Graduate Diploma modules:

>
>
>
>

Academic Skills
Advanced Grammar and Vocabulary
Introduction to Intercultural Communication
International Business Environment

Core modules for the Diploma and
Certificate:

>	Applications of English in Academic and
Professional Contexts
> Analytical and Critical Thinking Skills
> Business Policy
Both programmes are completed with a dissertation/
research project.
Why choose this course

You should consider this programme if one or
more of the following apply:
>	
your current level of qualification does not
meet the required level for direct entry to an
Aston Business School postgraduate degree
programme;
>	
you want to study a postgraduate
qualification in a different subject to your
degree;
>	
you want to build confidence and improve
subject knowledge before starting a
postgraduate degree programme;
>	
and you need to improve your academic
English and/or study skills. (If this is the only
factor that applies, find out more about our presessional English programmes).
By successfully completing the Aston
International Pre-Masters Programme, students
will have a guaranteed pathway to a variety of
Aston Business School postgraduate degrees.

Career prospects
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This programme will prepare you for a Masters
degree programme that will give you access to
careers across a wide range of sectors, both in
the UK and internationally.

Discover how to undertake security valuation and
portfolio management by studying equity, debt and
derivative markets in domestic and international
sectors, and learn about the key techniques used by
financial traders. This course has a strong focus on
the practical application of finance within a trading
or corporate setting. Your studies will culminate
in a financial analyst evaluation of a UK listed
company for your final project. During the summer
term you will also have the opportunity to attend a
workshop designed to help students taking the CFA®
(Chartered Financial Analyst) Level I examination.

Core modules

>	Valuation of Investments (A)
>	Valuation of Investments (B)
>	Quantitative Methods for Finance
>	Trading Techniques
>	Security Analysis
>	Investment Management
>	Business Finance
>	International Finance
>	Ethics in Academic Practice
>	Professional Development Programme (PDP)
> Investment Analysis Project

Professional accreditation:

You will have the opportunity to attend preparation
and revision classes for the Chartered Financial
Analyst (CFA) Level One course. You will also have
the opportunity to complete the Bloomsberg Market
Concepts Certification - an industry recognised
qualification.
Why choose this course?

Practice your skills with a dedicated Bloomberg
Trading Room facility. You can get ahead
of the competition by practising in a life-like
environment and gaining hands-on experience
with Bloomberg’s database.

Additional entry requirements

Demonstrable quantitative and analytical skills,
having studied some finance, economics or
other quantitative modules at undergraduate
level.

Career prospects

This course provides you with the knowledge,
understanding and skills needed for a career in
the financial, insurance and corporate sectors.
Recent graduate positions include: Auditor,
PricewaterhouseCoopers (Italy); Financial
Analyst, Deutsche Bank (UK); Investment
Manager, Bank of China (China), CRM,
Volkswagen.

LLM International
Commercial Law
Programme overview

This varied and stimulating course is open to
graduates in law and other academic backgrounds.
If you didn’t study law at undergraduate level, this
degree will help you gain an understanding of how
law and business intersect within a global context.
For those with law qualifications, this course gives
you the opportunity to develop advanced legal
knowledge and a broad range of business skills.
Globalisation has made international commercial law
increasingly significant. We examine the basis of the
relationship between law and business within this
context.

Core modules

>	Law and Business in a Global Context
>	Dissertation

Elective modules

>	Competition Law and Policy
>	Banking and Financial Services Regulation
>	International Insolvency and Restructuring
>	Legal Risk Management
>	Internet Law
>	Corporate Governance Regulation and
Compliance
>	Intellectual Property Strategy and Management

Elective business modules:

>	Employee Relations in Context
>	Employment Law
>	Economic Environment of Business
>	International Business Strategy
>	Strategic Global Outsourcing and Offshoring
>	Business Finance
>	International Finance
>	Global Business Ethics
Why choose this course

The course is delivered in partnership by our
Law School and Business School. This means
you will get the best of both worlds, benefitting
from a first-class law and business education.

Career prospects

This course will prepare you for a successful
career in a range of legal roles, such as a
solicitor, barrister, company secretary, in-house
counsel or legal advisor. It will also develop
your understanding of business and equip you
with a range of transferable skills to enhance
your employability. Our graduates have been
successful in securing positions with prestigious
international companies and at leading
consultancy firms.
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MSc Strategy and
International Business

MSc Strategic Marketing
Management

MSc Work Psychology
and Business

Programme overview

Programme overview

Programme overview

Ranked 4th in the UK in the Eduniversal Best
Masters ranking 2017 this course will give you the
understanding of strategy needed to excel in a
management consulting, strategy or international
management career. You will acquire the knowledge
and skills needed to analyse companies’ strategic
situations and solve complex strategic problems. You
will also develop your ability to assess and develop
business strategies and operational plans, in a
national, international and cross cultural context whilst
working on live business projects.

Core modules
>
>
>
>
>
>

Strategic Management
Advanced Topics in Strategy
International Business Strategy
International Business
Ethics in Academic Practice
Professional Development Programme (PDP)

Elective modules
>
>
>
>
>
>
>
>
>
>
>
>
>

Management Consulting
Intellectual Property Strategy and Management
Business Finance
International Finance
Strategic Business Sustainability
People and World Organisations
Marketing Management
International Marketing Management
Strategic Global Outsourcing and Offshoring
Entrepreneurial Strategies
Management of Innovation
Advanced Topics in International Business
Economic Environment of Business

Marketing and strategy is the core of any successful
business and effective business leaders need to
understand marketing from a strategic perspective.
This course advances your understanding of
marketing processes and procedures, including
marketing research, marketing planning, marketing
communications and brand portfolio building. A
selection of specialist marketing modules enables you
to focus on what is right for your career.

Core modules
>
>
>
>
>
>
>

Marketing Management
Marketing Research
Marketing Strategy
Analysis for Dissertation Research
Ethics in Academic Practice
MSc Dissertation
Professional Development Practice (PDP)

Elective modules

(select four modules)
> Intellectual Property Strategy and Management
> Accounting for Non-Financial Managers
> Strategic Business Sustainability
>	Marketing Channels and Strategic Salesforce
Management
> Integrated Marketing Communictions
>	Consumer Behaviour
>	Strategic Brand Management
>	Services Marketing
>	International Marketing Management
>	Digital Marketing
>	Strategic Management

Non-marketing modules
(select up to two modules)

Why choose this course?

The unique combination of strategy,
management consulting and international
business in this course will provide you with
a solid foundation for a career in strategy,
management consulting or International
management.

Career prospects

Our graduates have secured employment in a
wide range of roles such as Business Process
Analysts, Consultants, Senior Analysts and
Transformation Consultants. This has involved
working for organisations including Jaguar Land
Rover, Hyundai, Deloitte (Spain) Deutsche Bank
(UK) and Cap Gemini Consulting (Germany).
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>	Intellectual Property Strategy and Management
>	Accounting for Non-Financial Managers
>	Strategic Business Sustainability
>	Strategic Management

Professional accreditation

Upon completion of this course, you will eligible for
direct entry onto the Chartered Institute of Marketing
(CIM) Diploma in Professional Marketing.
Why choose this course?

To become a well-rounded marketing professional,
capable of working in a variety of sectors.

Career prospects

Our graduates have secured employment in a
wide range of roles including product and brand
management, market research, market planning and
product development, marketing communications,
media relations and direct marketing. This has
involved working for organisations including
Hyundai, Pepsico International (Cyprus), Merlin
Entertainments (Austria), Tesco (UK) and L’Oréal.

Focus on the study of practical, real-world
organisational and business issues, combined with
the academic and scientific rigour of occupational
psychology as an applied science.

Core modules

>	Organisational Behaviour
>	Learning and Talent Development
>	Workplace Design and Health
>	Research Methods in Human Resource Management
and Business and Organisational Behaviour
>	Assessment Performance and Reward
>	Strategy, Change and Leadership
>	Careers and Counselling
>	Ethics in Academic Practice
>	Professional Development Programme (PDP)

Elective modules

Choose one:
>	Accounting for Non-Financial Managers
>	Organisational Behaviour: Theory and Practice
>	Strategic Business Sustainability
>	Strategic and International Human Resource
Management
>	Marketing Management
>	Operations Management
>	Strategic Management
>	Management of Innovation
>	Economic Environment of Business

Professional accreditation

This course is British Psychological Society (BPS)
accredited, and completion leads to the academic
basis for the BPS Chartered Occupational Psychology
qualification (QOccPsych).
Why choose this course?

Studying business alongside specialist work
psychology modules will enable you to build your
career as an occupational psychologist or in
other professional roles.

Additional entry requirements

BSc in Psychology (UK only), or a recognisable
equivalent degree (overseas). Only undergraduate
Psychology degrees which give the Graduate
Basis for Registration will allow students to
progress to Chartered Occupational Psychologist.

Career prospects

Recent graduate positions include: Business
Psychologist (Recruitment and Assessment),
Jaguar Land Rover; Learning and Development
Specialist, Network Rail; Occupational Health
and Wellbeing Scientific Advisor NPower;
Occupational Psychologist, NHS; Research
Scientist, BAE Systems.

Online courses
Course materials and a support network are built into
the virtual learning environment. You’ll be guided through
structured modules and assessed in a variety of ways,
including group assignments, individual projects, as well
as written and oral examinations. A Student Support
Advisor will work with you every step of the way to
ensure you always have the support you need. You
remain a student and a professional, so what you learn
today can be applied tomorrow in real-world situations.
For more information please visit studyonline.aston.ac.uk

MSc Business and
Management
Programme overview

This course features a versatile business curriculum
focused on developing highly competent professionals
and managers. Open to students from all disciplines
and academic backgrounds, the programme refines
business competencies while introducing essential
management principles and techniques. Graduates
gain a wide range of skills including interpreting
financial statements, developing marketing and pricing
strategies, as well as understanding strategies in
tandem with innovation processes.

Pathways

>
>
>
>

Global Business
Finance
Organisational Development
Entrepreneurship

MSc International
Accounting and Finance
Programme overview

This course builds upon your existing expertise in
accounting and finance to help further your career and
cement your credibility. We expect graduates of the
programme to progress toward senior management
roles in their organisations.

Core modules

> International Business Finance
> Sustainability Accounting and Accountability
> Corporate Governance, Regulation & Compliance
> Global Business Ethics
> Strategic Management Accounting
> International Business
> The Economic Environment of Business
> 	The International Context of Corporate Reporting
and Assurance
> International Accounting and Finance Project
Aston Business School
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School of
Engineering
& Applied Science

For full details of entry
requirements for each
course please visit the
course page on our website:
www.aston.ac.uk/eas

The School of Engineering
and Applied Science has
a long tradition of quality
teaching, and a reputation
for internationally-known,
cutting-edge research.

What makes us stand out?

Quality
We’re very proud to say that many
of our courses have received
professional accreditation from
the relevant subject organisation,
which means that our courses
have undergone a strict quality
assurance process. Our students
can feel confident that they are
studying at a university at which
recognised industry standards
are being met.

We offer a range of inspiring,
professionally-relevant courses
which will prepare you for a
successful and rewarding career.
By choosing postgraduate study
with us, you will be exposed to
new ways of thinking and gain a
competitive edge in the exciting
world of engineering and applied
science.

In 2017 Aston University
received a Gold award, the
highest possible accolade, in
the Government’s new Teaching
Excellence Framework (TEF).
The same year, the School of
Engineering and Applied Science
received the Athena SWAN Silver
Award for the second time. This
award recognises our progress
in addressing gender and other
inequalities in academia.

There is a great breadth of
academic expertise in the school,
with staff broadly categorised
into the following subject areas:
computer science, electronic
engineering, engineering systems
and management, mechanical
engineering and product design,
as well as chemical engineering
and applied chemistry, and
mathematics.
We are always investing in people
and facilities, such as state-ofthe-art laboratories, so that we
can continue to deliver the best
to our students. We want you to
achieve your full potential.

Research
Internationally known for exciting
research projects

Industry
Strong connections with industry
leaders in the world of science,
engineering and technology.
The School of Engineering &
Applied Science has received the
Athena SWAN Silver Award. This
prestigious award recognises our
progress in, and commitment
to, addressing gender and other
inequalities in academia.

Accreditations
Many of our courses are accredited
by world-leading organisational
bodies such as the Institution of
Mechanical Engineers (IMechE),
Institution of Engineering and
Technology (IET), and the Chartered
Management Institute (CMI).

E
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MSc Artificial Intelligence*

MSc Computer Science

Programme overview

Programme overview

Our programme is very practical and features
strong connections with industry. The collaboration
with companies within our Industry Club takes
place via guest lectures, field trips, showcases and
industrial MSc dissertations. A special module on the
programme is dedicated to AI in practice. A strong
focus is on theory and practice of machine learning.
Key aspects of robotics are also taught. The teaching
team consists of academics with active research in
many areas of AI, including members of the Aston
Lab for Intelligent Collectives Engineering.

Core topics

>	AI in practice
>	Machine learning, including deep learning
>	Robotics and autonomous systems
>	Computer vision
>	Computational intelligence
>	Multi-agent systems
>	AI and Ethics
Why choose this course

Develop vital skills and practical experience
through access to companies in our Industry
Club.

Career prospects

This new MSc programme is very timely as it will
enable graduates –in addition to embarking on
relevant industry careers – to take on prestigious
PhD positions, starting from the first generation
of graduates.

* subject to full approval for 2019 entry

Boost your career, and access roles in a rapidly
growing industry with an MSc qualification in
a highly in-demand skill set. With no specific
subject qualification required, this course offers
an opportunity for non-computing graduates to
pursue a career in computing and become an
industry-accredited professional. Gain the theoretical
underpinning needed to support sound analysis,
design and delivery of technology solutions,
and develop a systematic understanding of the
software development process, and the associated
professional skills necessary in practice.

Core modules

>	Foundations of Object-oriented Programming
>	Team Project
>	Software Engineering
>	Human Computer Interaction
>	Introduction to Databases
>	Dissertation

Elective modules

>	Data Structures and Algorithms
>	Software Project Management
>	Information Security
>	Reliability in Software Engineering
>	Data Mining
*Optional modules will be subject to staff availability,
and minimum number of students
Why choose this course?

Computer Science at Aston is ranked in the Top
10 in the UK (Guardian University Guide 2017).
Get professional experience, and a wide
perspective on IT and business through
employment at collaborating host companies, or
the Aston student-run software company.

Additional entry requirements

A bachelor’s degree in a non-Computing subject,
completion of an aptitude test and interview.

Career prospects

This programme will equip you for a leadership
role within the computer science industry.
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MSc Engineering
Management

MSc Supply Chain
Management

Programme overview

Programme overview

The Engineering Management MSc provides you with
a knowledge and understanding of the principles
underlying the strategic management of engineering
and technology businesses. Addressing the full range
of management knowledge and skills needed for a
successful career, this course is designed for those
with an undergraduate degree in a technical degree
who aspire to a managerial career.

Core modules

>	Strategic Finance
>	Strategic Management
>	Project Management
>	Management of Change
>	Human Resource Management
>	Research Methods
>	Corporate Social Responsibility
>	Management in Engineering Enterprises
>	Major Project

Elective modules

Two of the following:
>	EM4006 New Product Development
>	EM4007 Lean & Agile Manufacture
>	EM4031 Logistics and Transportation
>	BSM930 Entrepreneurial Strategies

Professional accreditation

Professionally recognised and accredited by the
Chartered Management Institute (CMI). The course is
shown to meet the rigorous demands of high quality
management education that is recognised across the
globe.
Why choose this course?

Strong international content will teach you
about industry abroad and enhance your global
employability.

Career prospects

This programme is perfect for those seeking a
career in the Engineering and Manufacturing
sectors, particularly those who aspire to senior
management positions. Project management
roles are a common first destination. Previous
graduates have secured engineering roles at
organisations such as Rolls-Royce plc, Nestlé,
Caterpillar, Ericsson and Department of Civil
Aviation.

This course is delivered in a collaboration between
the School of Engineering and Applied Sciences and
Aston Business School which makes this course
distinctive from other universities. You will receive
a broader knowledge from academics across both
schools who work closely with business and industry.
You will develop knowledge and understanding of
the theoretical and applied perspectives of supply
chain management and logistics, along with specific
areas of supply chain management by studying
specialist modules. These areas include: relationships,
partnering, ERP, simulation, purchasing, contracts,
planning and optimisation.

Core modules

>	Simulation for Managerial Decision Making
>	Operations Management
>	Managing Multi-organisational Enterprises and
Enterprise Systems
>	Strategic Finance
>	Strategic Management
>	Project Management
>	Research Methods
>	Supply Management
>	Logistics and Transportation
>	Major Project

Professional accreditation

This course is fully accredited by the Chartered
Institute of Purchasing and Supply (CIPS) and the
Chartered Management Institute (CMI). On successful
completion of the degree, you will also be awarded a
CMI Diploma in Management. Aston Business School
is in the 1% of business schools globally with triple
accreditation from the leading accreditation bodies in
the UK, Europe and USA, AMBA, AACSB and EQUIS.
Why choose this course?

This programme is suitable if you are seeking a
career in the supply chain management sector,
particularly if you aspire to senior management
positions.

Career prospects

Recent graduates have gone on to secure
roles such as Supply Chain Analyst, Assistant
Purchasing Manager, Corporate and Planning
Strategist, Quality Controller, Planning Executive,
Procurement & Logistics Expeditor, Junior
Resources Manager and Content Operations
Executive. They work at some of the major
companies in the industry, including Nissan,
Accenture, Royal Mail, Royal Air Force, and
Singapore Airlines Cargo.

Engineering & Applied Science

43

MSc Product Design

MSc Mechanical
Engineering

Programme overview

This programme is for students with a background
in design, engineering or related areas and will
equip you with the necessary tools to develop your
own product ideas and innovations, start your own
design business, or enter new product development
organisations. The modules aim to develop your
innovation skills and knowledge required to achieve
successful product design development and
innovation, and develop a critical understanding of
sustainable factors. The course creates opportunities
for students to originate new ideas and model or
prototype design solutions that will meet perceived
manufacturing, marketing and consumer needs.

Programme overview

This course aims to develop students’ performance
prediction skills required in the modern engineering
environment, especially design, performance
estimation and optimisation processes. It gives
students the opportunity to apply state-of-the-art
methods to industrially-relevant products, and to
explore the process of design and development and
the value of the design and evaluation cycle.This
programme is designed for engineering and science
graduates, providing a wide exploration of new and
advanced technologies.

Core modules

Core modules

>	Product Introduction Processes
>	Research Project
>	Design Realisation
>	Design Studio
>	Design for People

>	Sustainable Energy
>	Design Studio
>	Research Project
>	Major Project

Elective modules

Elective modules

>	Project Management AND/OR Product
Development Process
>	Water Treatment Technologies AND/OR Practical
Numerical Methods
>	Computational Fluid Dynamics and Applications
>	CAD Principles and Materials Selection
>	Advanced Computer Aided Design (ADVCAD)
>	Finite Element Analysis and Solid Mechanics

>	Strategic Management and Finance
>	Project Management
>	Management of Innovation
>	Consumer Behaviour
>	Interaction Design
>	Human Computer Interaction
>	Workplace Design and Health
>	Design Innovation: Historical and international
dimensions
>	CAD Principles and Materials Selection
>	Advanced Computer Aided Design (ADVCAD)

Professional accreditation

The MSc Mechanical Engineering is accredited by
the Institution of Mechanical Engineers (IMechE) for
the purpose of meeting the additional educational
requirements of Chartered Engineer (CEng).

Course

Why choose this course?

MSc Mechanical Engineering

Additional entry requirements

The module choices on my course suit
my chosen career perfectly. The staff are
all very friendly, which makes me feel
right at home! Meeting new people is
made very easy. The range of different
activities the university holds through the
week is definitely the highlight of my stay
here so far.”

Impressive accreditation, a worldwide reputation
and staff who can pass on the benefit of genuine
commercial experience will enhance your
prospects and progression.
First or second class UK Honours Degree in
engineering, physical science, mathematics or a
related subject.

Career prospects

Practical engineering modelling, research and
project management skills will help your career
progression in industries where computer-based
technology is required including manufacturing,
R&D, science, IT, design and academia. Recent
graduates have been employed in a range of
jobs including: product development with a
manufacturer of domestic heating products and
computer aided design with a manufacturer of
military/surveillance equipment.
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Professional accreditation

This programme is fully accredited by the Institution
of Engineering Designers leading to Chartered
Engineering status (CEng).
Why choose this course?

Creativity will underpin much of the interactive
work during this course. Developed ideas can
be manufactured using a variety of techniques
including the use of our range of Rapid –
Prototyping equipment.

Additional entry requirements

A minimum of a first or good second class UK
Honours Degree in product design, engineering,
or a business related subject. Graduates with at
least two years relevant design work experience
are particularly encouraged to apply. Students
without such experience may be admitted based
on individual merit.

Career prospects

On completion of this course you should be
able to develop your own product ideas ‘ready
for manufacture and marketing’, start your own
design business enterprise, or enter new product
development organisations.

MSc Communication
Systems and Wireless
Networking
Programme overview

This course is designed to address the rapidly
increasing demand for qualified engineers and
managers with well- equipped knowledge in modern
communication systems and wireless networks.
You will focus on a wide range of subjects from
fundamental information and communications
technology (ICT) to contemporary developments in
the wireless and mobile industries. You will develop
the knowledge and skills needed to equip you for an
intellectually challenging career as a qualified engineer.

Core modules

>	Telecommunications Networks and Quality of Service
>	Radio Systems and Personal Communications
Networks
>	Digital Communication and Information Theory
>	Pervasive and Mobile Communication Networks
>	Project Management
>	MSc Dissertation

Elective modules

>
>
>
>

Mobile Data Networks
Broadband Wireless Networks
Optical Communications Systems
Internet of Things

Professional accreditation

Postgraduate programmes in Electrical and Electronic
Engineering have previously been accredited by
The Institution of Engineering and Technology (IET).
Accreditation for this newly revised course is pending.
Get free student membership throughout your studies.
Why choose this course?

Move into the high-demand area of
communication systems and wireless networking.
Gain the skills needed to be part of a rapidly
developing industry with fast-paced exciting
developments. Access a wide range of dedicated
facilities and specialist laboratories. Access
the facilities of the world-renowned innovative
research institute, the Aston Institute of Photonic
Technologies.

Additional entry requirements

A first or good second class Honours Degree in
a relevant engineering field, science or closely
related discipline

Career prospects

Our students have worked with organisations
including: BlackBerry, BT, BAE, Daconi, Jaguar
Land Rover.
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MSc Smart Telecom and Sensing Networks
(SMARNET)
Programme overview

SMARTNET is a unique two-year Erasmus Mundus
Joint Master Degree programme supported by
European Union funding. You will receive training
in the interdisciplinary fields of photonics and 5G
wireless technologies for data communication,
sensing and data processing. Offered jointly by
three universities, you’ll benefit from distinctive and
complementary academic qualities, and strong
educational and research environments.
Alternatively, a non-Erasmus, Aston University only,
SMARTNET training pathway will be developed,
leading to a standard MSc qualification (180 credits).
You will study a range of subjects highly relevant to
both industry and society. And critical subjects for
the global future of information and communication
technologies.

Core modules

As a student of the collaborative SMARTNET
programme, you will be able to choose to follow one
of six pathways:
> 5G Broadband Infrastructures
> Advanced 5G Network Architectures
> Energy Efficient Smart Networks
> High Capacity 5G Network Systems
>	Connectivity Technologies for Smart Network
Systems
> Big Data Analytics and 5G
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Why choose this course?

Study one of engineering’s key multidisciplinary
areas of the future. Develop the skills and
knowledge to contribute to the development
of a 5G network infrastructure. As part of the
Erasmus Mundus programme, graduate with
two full MSc qualifications. Benefit from close
relationships with 17 industrial partners

Additional entry requirements

A bachelor’s degree in telecommunications,
electronics, electrical engineering, computer
science, physics, mathematics or similar.

Career prospects

You will benefit from the strong involvement
of industrial partners in the programme and
will be encouraged to carry out a number of
industrial visits to enhance your MSc project.
On completion, you will be a telecommunication
engineer with a broad and interdisciplinary
background, and a global vision of your
field, who will be able to move ideas from
basic science to application and thrive on
collaboration. Potential demand from industry for
a workforce with these skills is enormous.

MSc Photonic Integrated Circuits, Sensors and Networks
(PIXNET)
Programme overview

PIXNET is a two-year Erasmus Mundus Joint Master
Degree programme supported by European Union
funding. You will receive high-quality training in
photonic integration for communication, sensing and
switching. Offered by a consortium of universities,
you’ll benefit from distinctive and complementary
academic qualities, and strong educational and
research environments. Alternatively, a non-Erasmus,
Aston University only, PIXNET training pathway will be
developed, leading to a standard MSc qualification
(180 credits). Both programmes are aimed at training
students to design, realise and assess innovative
integrated devices based on photonic technologies.
The Erasmus programme is an interdisciplinary,
multinational initiative to train telecommunication
and electrical engineers to investigate the adoption
of Photonic Integrated Circuits (PIC) as the
central element in the evolution of information and
communication devices.

Core modules

Specialisms
As a student of the collaborative PIXNET programme,
you will be able to choose to follow one of the
following pathways:
>	Optical switching technologies
>	Optical transceiver technologies
>	Design of Photonic integrated devices
>	Photonic integrated devices manufacturing
>	Theory and techniques for photonic integrated
devices

Why choose this course?

Study a crucial field in the evolution of
information and communication devices.
Receive high-quality training, specialising
in photonic integration for communication,
sensing and switching. As part of the Erasmus
Mundus programme, graduate with two
full MSc qualifications. Benefit from close
relationships with key industrial partners. The
strong involvement of industrial partners in
the programme will offer you the opportunity
to bridge the gap between your academic
knowledge and practical application. You will be
encouraged to carry out a number of industrial
visits to enhance your MSc project.

Additional entry requirements

A previous qualification in Electrical Engineering,
Electronics, Telecommunication Engineering,
Physics or a related discipline.

Career prospects

Both programmes will equip you not only
with the theoretical knowledge but also the
transferable skills in related disciplines that will
give you the potential to play a leading role in
the evolution of integrated photonics as a key
technology for the future development of many
modern industries, including ICT, biomedical
industries, sensing and the aerospace industry.
Graduates from similar previous programmes
have gone into senior level roles in industry or
onto PhD study in European institutions.
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Research Degrees

MSc by Research

PhD

If you would like to pursue a rewarding postgraduate
research degree that matches your interests and
prepares you with high-level knowledge and skills,
Aston is the right choice.

Programme overview

Programme overview

Research within the School of
Engineering and Applied Science
focusses on four strategic themes:

> Communications and Sensing
>	Health technologies (biomedical engineering,
biomimetic materials, bioinformatics)
> Bioenergy and Sustainability
>	Understanding complex systems (physical,
statistical/probabilistic, and knowledge
engineering)
Each of these represents major challenges
and opportunities at an international level. By
focussing our efforts and working together with our
collaborators across the world, we are making an
important contribution to long-term solutions to a
number of critical problems affecting societies and
economies.
In addition, the School has established five Research
Institutes to strengthen its strategic activities:
> Aston Institute of Photonic Technologies
> Aston Institute of Materials Research
> Aston Logistics and Systems Institute
> European Bioenergy Research Institute
> Systems Analytics Research Institute
We have an exciting and vibrant research
environment that enables you as a research degree
student to engage in various research events and
seminars. There is also a dedicated research society,
which organises social and academic events.

The MSc by Research is a one year full-time, or
two year part-time, thesis based research degree
for students looking for a research programme,
but who may not be ready or able to commit to
the three years’ study required by a traditional PhD
programme.

Programme content (including any
research methods courses)

As part of the MSc by Research, students complete
the following training:
>	Research Skills and Professional Development - a
generic research skills module.
>	Specialist Research Skills and Techniques - this
module is individually tailored to help students
develop the specialist (i.e. subject and discipline
specific) research knowledge and skills necessary
for their project.
>	Creation of an Individual Training Plan - to be
agreed with your supervisor at the outset and
updated at the three monthly reviews
MSc by Research students must submit a thesis for
examination; the thesis is the primary focus of this
degree.

Our PhD programme is designed to train Doctoral
students who aspire to become future academics or
professional industry researchers.

Programme content (including any
research methods courses)

At the start of your PhD you will undertake taught
Research Methods modules designed to provide you
with the necessary skills to successfully complete
your PhD and to develop as a well-rounded
researcher. You will then typically concentrate on
obtaining ethical approval for your research, before
focusing on data collection and analysis. Finally, you
will write up your research, and develop your thesis.
Entry requirements

You should have been awarded, or expect to
achieve, a first or upper second class Honours
degree or a Master’s degree in a relevant subject
(or an equivalent qualification from an overseas
institution). We also consider applicants who have
substantial and significant work experience in a
relevant field. TOEFL IBT: 93 (23 in Writing, 19
in Speaking, 18 in Reading and 19 in Listening).
IELTS: 6.5 (6.0 in Writing Speaking, Reading and
Listening). Pearsons English language test: 63
with no less than 57 in each band.

Alina Patelli
Course

PhD Computer Science

I was exposed to a vibrant,
enthusiastic research community with
ties throughout the university and
beyond. This fostered my passion
for artificial intelligence and provided
me with the experience and new
skills needed to develop into an
independent young investigator.”
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School of
Life & Health
Sciences

For full details of entry
requirements for each
course please visit the
course page on our website:
www.aston.ac.uk/lhs

Our ethos is to produce
graduates who can make
a real difference to the
communities they serve in
both the UK and across the
world.

Careers:
We regularly review our courses
to ensure that we produce fresh,
industry informed curricula
that will prepare you for the job
market or further study. So it’s
not surprising that our graduates
go on to develop their careers in
industry, in organisations like the
NHS or continue their research
at a range of world-leading
universities.

We are acknowledged as one
of the leading centres of health
sciences within the UK with
an outstanding reputation for
teaching and research. The
integration of this research into
our courses and teaching gives
our students a distinct advantage
in having access to the latest
trends, thinking, issues and
research in their particular field of
study.

Facilities:
Each of our subject areas includes
a range of facilities available for
student use. This includes:
	Lecture and seminar spaces
with modern audio-visual
equipment

There is a huge breadth of
academic expertise within the
School and a range of courses
at postgraduate taught, research
and continuing professional
development levels.

	Well-equipped and modern
student, project and research
laboratories

94% of our research
is World Leading
or Internationally
Excellent (3*/4*)
in the most recent
Research Excellence
Framework
REF 2014

Top 200 in the world
2018 QS Graduate
Employability Rankings

Top 20 in the UK and
top 50 in the world
for International
Outlook
Times Higher World Rankings
2018

	State-of-the-art equipment
across all course areas
	On-site public optometry and
audiology clinics.

We pride ourselves on providing
a modern, supportive and
multicultural environment and we
are committed to giving you the
opportunity to achieve your full
potential.

Funding:
Each year Aston offers a range
of scholarships to talented
postgraduate students. You can
find up to date details at
www.aston.ac.uk/scholarships
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MSc Cognitive
Neuroscience

MSc Health Psychology
Part-time online also available

Programme overview

Programme overview

Throughout this course you will gain an in depth
understanding of the theory underpinning health
psychology and develop your understanding of
advanced research methodology and analysis
of qualitative and quantitative data to carry out
independent work of publishable standard. You will
also develop awareness of the contribution and
application of health psychology within multicultural
and multidisciplinary settings and professional and
transferable skills in preparation for becoming a health
psychologist.
>	12 months full-time on-campus
>	18 months (up to a maximum of 3 years) part-time
online

Unique in its emphasis on specialist training in
cognitive neuroscience, coupled with transferable
research skills for career and professional
development, this course will see you study specialist
modules in cognitive neuroscience that combine
theory and practice. It is especially recommended
to those who want to specialise in the area of
cognitive neuroscience, get a feel for research before
embarking on a PhD or to enhance your CV by
studying a research-related masters qualification.

Core modules

> Introduction into Cognitive Neuroscience
> Mini-project in Cognitive Neuroscience
> Advanced Statistical Analysis
> Advanced Methods in Cognitive Neuroscience
>	Advanced EEG and MEG Methods in Cognitive
Neuroscience
>	Communication Skills in Research / Professional
Development
>	Research Dissertation

Use state-of-the-art facilities including the Aston
Brain Centre and psychophysical laboratories.
Study at a school ranked 5th out of 97 UK
higher education institutions for Research in
Allied Health Professions and Studies in the
most recent REF (2014).

Entry requirements

A good honours degree (usually 2:1 or above)
from a recognised university in Psychology or a
related field such as Biology.

Career prospects

Our graduates have taken on roles including:
Further studies, for example completing a PhD
at universities such as Aston, Cardiff, Derby,
Liverpool, Sussex and Warwick. Research and
clinical roles such as research assistant, data
analyst, clinical researcher and trainee clinical
physiologist/ neurophysiologist within the NHS.
Educational roles within secondary education or
as educational consultants.
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Jaspreet Kalsi
Course

MSc Health Psychology

Destination

ABA Tutor, ABAble Ltd

Accredited by the British Psychological Society
(Stage 1 Professional Training in Health
Psychology) and commended for the support
provided to students. Ranked 5th in the UK and
32nd in the world (Health Economics/ Public
Health, Eduniversal Masters Rankings, 2018).
Programme staff are internationally recognised
researchers in their fields and work with a
number of NHS clinics and other health related
organisations. Use purpose-built psychology
labs, including a focus group room, driving
simulator and cubicles equipped for cognitive,
behavioural and physiological testing.


Entry requirements

>	Qualitative Research Methodology
>	Quantitative Methods and Advanced Statistics
>	Health Behaviours
>	Health Inequalities Across the Lifespan
>	Illness Processes and Behaviour
>	Professional Issues and Applications
>	Research Project

A good honours degree of 2.1 or above
that confers eligibility for Graduate Basis for
Chartered Membership (GBC) of the British
Psychological Society (BPS). Students who
have a psychology degree with an equivalent
grade of a 2.1 or above from a non UK institution
but do not have GBC will be advised to apply
to the BPS for recognition of their degree and
confirmation of eligibility for GBC. This will be a
requirement of securing a place on the course.

Professional accreditation

Career prospects

Core modules

Why choose this course?

Why choose this course?

This course is accredited as Stage 1 training in
Health Psychology by the British Psychological
Society (BPS). In order to become a Chartered
Psychologist with the BPS or a registered Health
Psychologist with the Health and Care Professions
Council (HCPC), students must complete Stage 1
and Stage 2 training. There will be opportunities to
undertake Stage 2 training at Aston alongside a PhD.
That course is approved by the HCPC and will make
graduates eligible to apply for registration as a Health
Psychologist. Further details of how to become a
Chartered Psychologist are available from the BPS.

This course will prepare you for membership
of the BPS Division of Health Psychology and
towards further training and employment in
health psychology. Upon successful completion
of this course, you can apply for posts as a
research assistant or assistant psychologist
working in a range of chronic health or health
promotion fields. Recent graduates have
gone on to secure roles within a variety of
organisations like the NHS, private clinics,
charities and educational institutes, recent
roles include: Assistant Psychologist, Health
Psychologist, Children & Young Person’s
Therapeutic Support Worker, Counselling
Therapist, PhD student.

Studying at Aston not only enhanced my
existing skills and qualities, but it also
played a significant role in developing
my career. Aston is not only dedicated
to supporting their students in their
academic studies, but they are also
passionate about producing wellrounded, employable graduates.”
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Optometry/ Ophthalmic Science (PgCert, PgDip, MSc and Professional Doctorate)
Programme overview

This suite of courses have been designed for existing
practitioners in optometry who are looking to gain
particular skills or knowledge to perform their roles
more effectively, or to progress within this industry.
Offered via distance learning each of these awards
are delivered on a part-time distance learning basis
in order to fit into your life. The flexible credit
accumulation means that you can work towards
whatever level of qualification most suits your
current needs and lectures are pre-recorded allowing
you to study at a time that suits.

Course details

You will initially enrol on the postgraduate framework
of flexible credit accumulation in the School of Life &
Health Sciences. You have the option of taking each of
the three stages of the course in order (PgCert, PgDip
then MSc), or it is possible to exit the course at any of
the stages, enabling you to be flexible with your level
of commitment at the outset. Taught credits are valid
for 5 years, so students studying for an MSc / PgDip
/ PgCert must complete their studies within 5 years of
enrolment. The doctorate requires 180 taught credits,
120 of which must be completed within 2 years of
enrolment, you are given 6 years to complete the full
doctoral programme.
> PgCert Optometry (60 taught credits)
>	PgDip Optometry (120 taught credits, to include
those studied as part of the PgCert)
>	MSc Optometry / Ophthalmic Science (120 taught
credits, to include those previously studied as part
of the PgCert and PgDip, plus a 60 credit narrative
research review dissertation)
>	Doctor of Optometry DOptom / Doctor of
Ophthalmic Science DOphSc (180 taught credits)

Why choose this course?

Flexibility to gain a postgraduate certificate,
diploma, masters or doctoral qualification that
fits in with your work and personal life. Select
the modules most relevant to your professional
practice and area of interest. Enables eye care
professionals to enhance their knowledge,
critical awareness of current issues, and to be at
the forefront of their academic discipline.

Entry requirements

A good honours degree (usually 2:1 or above)
from a recognised university in an ophthalmic or
biomedical field.

Additional entry requirements

2 years of professional qualification.
2:1 in UG degree for MSc/Doctorate.
Must be an optometrist or working within
optometry or ophthalmology. Recognised
Prior Learning can be applied for if you have
completed any further postgraduate courses /
qualifications; Max 60 RPL for doctorate and
max 40 RPL for masters.

Career prospects

The flexible framework aims to help enhance
career prospects of those practitioners
who cannot undertake full-time study. The
programme is designed to enhance professional
development and provides opportunity to
undertake practice-based research and thus
boost experience is various fields of optometry
and ophthalmic science. Hence providing
greater job opportunities.

PgDip/MSc for Overseas Pharmacists (OSPAP)
Programme overview

Why choose this course?

Core modules

Entry requirements

This course is for overseas pharmacy graduates to
convert their existing pharmaceutical qualification
to be recognised in the UK. It focuses on new
developments in key pharmaceutical sciences, clinical
pharmacy and pharmacy practice together with the
study of health service delivery and pharmacy law
and ethics within the UK.
> 9 months – Full-time Postgraduate Diploma
> 12 months – Full-time MSc
>
>
>
>
>

Professional Critical Skills
Applied Pharmacology and Therapeutics
Practical Therapeutics
Pharmaceutics in Practice
Pharmacy Law, Ethics and Practice

Professional accreditation

Successful completion of the course will allow you
to undertake a pre-registration placement, before
applying to register as a Pharmacist with the GPhC,
you will also gain an Aston University Diploma. Please
note the university is not responsible for the provision
of a pre-registration training place nor preparation for
professional qualifying examinations.

Accredited by the General Pharmaceutical
Council (GPhC). Specifically designed for
pharmacy graduates who gained their degree
outside the UK, but who wish to practice in
the UK. Top 20 in the UK (Pharmacology &
Pharmacy, 2019 Complete University Guide).
Aston Pharmacy School is the first and only
institution to be awarded a prestigious Regius
Professorship in Pharmacy by HM the Queen.
A pharmacy degree that enables you to register
as a pharmacist with the GPhC. Documented
approval from the GPhC prior to applying to
Aston is required, which may take up to two
months. In order to secure a place for this
course, we recommend applying for GPhC
approval before June of your chosen year of
entry and to the Aston OSPAP course before
July of your chosen year of entry. Applicants
whose first language is not English will be
required to provide evidence of English language
competency to both Aston University and the
GPhC. You will be required to undertake a
Disclosure and Barring Service (DBS) check
before starting. In addition to the normal
academic requirements, and in line with our
other regulated health professions, continuation
on the programme and award of these
registerable degrees is subject to fitness to
practise regulations.

Career prospects

Our OSPAP course has an excellent track
record of students obtaining and successfully
completing the pre-registration training.

Each taught module is worth 20 credits. The modules
that you will choose include:
>
>
>
>
>

Advanced Contact Lenses
Glaucoma
Nutrition and the Eye
Refractive Surgery
Retinal and Macular Disorders

Natalie Hulme
Course

OSPAP

Destination

Pre-registration Pharmacist, Boots

Aston had everything I needed to get
through this intensive course: modern
and sophisticated facilities, convenient
student accommodation and, importantly,
highly professional and dedicated
teaching staff.”
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MSc Drug Delivery
Programme overview

Designed to provide you with a comprehensive
overview of the drug development process from
concept to market, including hands-on experience
of pharmaceutical formulation and drug delivery.
You’ll gain a thorough understanding and awareness
of this specialist pharmaceutical sciences area,
the research methods required to complete a final
supervised research project and an overview of the
drug discovery process.

Core modules
>
>
>
>
>
>

Chemotherapy & Selective Toxicity
Drug Dosage Form & Design
Drug Discovery
Research Methods 1: Professional Development
Research Methods 2: Communication Skills
Research Project

Elective modules

> Principles of Product Analysis and Validation
> Drug Delivery and Targeting
Why choose this course?

Gain specialist skills and knowledge for a career
in the pharmaceutical industry or research.
94% of research in the School of Life & Health
Sciences was rated as being internationally
excellent or world leading (REF 2014).
Aston Pharmacy School is the first and only
institution to be awarded a prestigious Regius
Professorship in Pharmacy by HM the Queen.

Entry requirements

Applicants must possess a good honours
degree (minimum lower 2nd class) from a
recognised university in one of the following
subjects or a related field: pharmacy,
pharmaceutical science, pharmacology,
physiology, physical science, biochemistry,
biotechnology, chemistry, chemical engineering,
genetics, materials science or medicine.

Career prospects

Our suite of MSc pharmacy will prepare you for
pursuing careers in various disciplines in the
pharmaceutical industry including: analytical
sciences, formulation development, project
management, regulatory affairs, scientific
writing and further studies. Recent graduate
roles include: Associate Product Manager,
AstraZeneca; Formulation Scientist, 3M; Senior
Regulatory Approval Officer, Ministry of Health,
Malaysia.

MSc Pharmaceutical
Sciences
Programme overview

You will gain the skills and knowledge required as
a pharmaceutical scientist - the ability to provide
effective pharmaceutical formulation strategies for
current and future drug therapies and medicinal
products.

Core modules

>
>
>
>
>
>

Chemotherapy & Selective Toxicity
Drug Dosage Form & Design
Drug Discovery
Research Methods 1: Professional Development
Research Methods 2: Communication Skills
Research Project

Elective modules

> Principles of Product Analysis and Validation
> Pharmacology
Why choose this course?

 4% of our research was rated as being
9
internationally excellent or world leading (REF
2014). Top 20 in the UK (Pharmacology &
Pharmacy, 2019 Complete University Guide).
Aston Pharmacy School is the first and only
institution to be awarded a prestigious Regius
Professorship in Pharmacy by HM the Queen.

Entry requirements

Applicants must possess a good honours
degree (minimum lower 2nd class) from a
recognised university in one of the following
subjects or a related field: pharmacy,
pharmaceutical science, pharmacology,
physiology, physical science, biochemistry,
biotechnology, chemistry, chemical engineering,
genetics, materials science or medicine.

Career prospects

Our suite of MSc pharmacy will prepare you for
pursuing careers in various disciplines in the
pharmaceutical industry including: analytical
sciences, formulation development, project
management, regulatory affairs, scientific
writing and further studies. Recent graduate
roles include: Associate Product Manager,
AstraZeneca; Formulation Scientist, 3M; Senior
Regulatory Approval Officer, Ministry of Health,
Malaysia.

MSc Pharmacokinetics
Programme overview

Pharmacokinetics is a key aspect of drug safety
and investigates the fate of a drug in the body,
and how the substance is absorbed, distributed,
metabolised and eliminated. Develop your skills and
knowledge in the application of pharmacokinetics to
the design and optimisation of new therapeutics. This
course has been developed with an emphasis on
describing mechanistic approaches to assessing and
predicting the pharmacokinetics of drugs throughout
the drug development process. You will encounter
a broad range of experiences in the application
of pharmacokinetics from early discovery and
development, through to market authorisation and
clinical applications.

Core modules
>
>
>
>
>
>

Chemotherapy & Selective Toxicity
Drug Dosage Form & Design
Drug Discovery
Research Methods 1: Professional Development
Research Methods 2: Communication Skills
Research Project

Elective modules
> Pharmacokinetics

Why choose this course?

Top 20 in the UK (Pharmacology & Pharmacy,
2019 Complete University Guide). Aston
Pharmacy School is the first and only institution
to be awarded a prestigious Regius Professorship
in Pharmacy by HM the Queen.

Entry requirements

Applicants must possess a good honours degree
(minimum lower 2nd class) from a recognised
university in one of the following subjects or a
related field: pharmacy, pharmaceutical science,
pharmacology, physiology, physical science,
biochemistry, biotechnology, chemistry, chemical
engineering, genetics, materials science or
medicine.

Career prospects

Our suite of MSc pharmacy will prepare you for
pursuing careers in various disciplines in the
pharmaceutical industry including: analytical
sciences, formulation development, project
management, regulatory affairs, scientific
writing and further studies. Recent graduate
roles include: Associate Product Manager,
AstraZeneca; Formulation Scientist, 3M; Senior
Regulatory Approval Officer, Ministry of Health,
Malaysia.

MSc Regenerative
Medicines Manufacturing*
Programme overview

This course will enable you to develop a comprehensive
understanding of the broad class of medicines called
advanced therapy medicinal products (ATMPs). These
products include tissue engineered constructs and
cell and gene therapies such as stem cell products
and CAR-T cell immunotherapies. The course will
cover fundamental biological science underpinning
these medicines and also the wider commercial
considerations for translating them from lab bench
into clinic, including typical industrial manufacturing
processes and regulatory considerations. Taken
together, this will create a strong foundation for a
career in industry or academia either in research and
development or in business development.

Core modules

> Laboratory Competency Training
> Advanced Laboratory Skills
>	Professional Development and Research
Communication Skills
>	Cell and Molecular Biology
>	Applied Biotechnology
>	Regenerative Medicines Manufacturing: from lab
bench to industry
>	Advanced Materials, Devices and Manufacturing
Processes for Regenerative Medicine
>	Design and Manufacture of Regenerative
Medicine Products
>	Dissertation project
Why choose this course?

 his course has been shaped with input from
T
industry on skills and training needs of the
sector. It will provide industry-relevant skills for
manufacturing advanced therapies including cell
therapies such as stem cells and CAR-T cells,
along with tissue engineered products. Research
in Allied Health Professions and Studies ranked
5th out of 97 UK higher education institutions
(REF 2014). Top 25 in the UK for Biological
Sciences (Sunday Times University Guide,
2019).

Entry requirements

A good honours degree (minimum lower 2nd
class) from a recognised university in a biological,
biomedical or biochemistry based subject.

Career prospects

The focus of the course on industry challenges
will provide a strong foundation for careers
both in industry and academia across research,
development and commercial sectors.
*Subject to full approval.
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MSc Stem Cells and
Regenerative Medicine

Top-up modules in
Biomedical Science

PhD

Programme overview

Overview

We offer an extensive range of exciting research
opportunities through our suite of PhD programmes.
As a research student at Aston, you will make a
tangible and original contribution to knowledge in your
chosen specialist area and develop your research and
professional capacities to the highest level. There are a
range of research projects available to highly motivated
students in fields including:

Overview

> Applied Health
> Basic and Applied Neurosciences
> Molecular Biomedical Research
> Cell and Tissue Biomedical Research
> Ophthalmic Research.

Course types

In addition to already established projects we also
welcome you to submit your own relevant research
proposal.

Standalone Modules - credit bearing modules
which may be taken alone or alongside other
modules.

This course has been designed to provide you with a
high level of scientific knowledge and understanding from the molecular to the whole system level. It’s our
aim to enable you to develop an informed and critical
appreciation of recent scientific developments in stem
cell biology, its clinical and industrial application, as
well as a practical skill set for further research and
learning, e.g. PhD studies. To ensure this established
course remains at the forefront of its field we have
recently redeveloped its module content and
structure*.

Core modules

>	Laboratory Competency Training
> Essential Laboratory Skills
>	Professional Development and Research
Communication Skills
>	Cell and Molecular Biology
>	Applied Biotechnology
>	Stem Cell Biology and Differentiation
>	Tissue Regeneration
>	Ageing and Regenerative Medicine
>	Dissertation project
Why choose this course?

Combination of theoretical and practical modules
to provide a comprehensive curriculum in stem
cell biology and regenerative medicine. Research
in Allied Health Professions and Studies ranked
5th out of 97 UK higher education institutions
(REF 2014). Top 25 in the UK for Biological
Sciences (Sunday Times University Guide,
2019).

Entry requirements

A good honours degree (minimum lower
2nd class) from a recognised university in a
biological, biomedical or biochemistry based
subject.

Career prospects

Graduates from this course are prepared for a
research-focussed role in industry, including the
developing clinical field of stem cell therapies
of regenerative medicine, or academia. Recent
graduates have gone on to secure roles in
further research, in the form of a PhD or
research assistant, or undertaken careers in the
commercial and clinical sectors.
*Course re-development subject to approval.

58

Life & Health Sciences

We offer a range of accredited top-up modules
from our BSc Biomedical Sciences (Hons) degree
for science graduates who have a non-accredited
Honours degree but wish to pursue a career as a
biomedical scientist. These modules will allow you to
obtain the academic competences that are required
to apply to the Health Care and Professions Council
(HCPC) for registration as a Biomedical Scientist. All
modules are available via on-campus attendance and
most are available by distance learning.

Core modules

> Applied Molecular Biology
> Cell Biology
> Cellular Pathology
> Clinical Microbiology
> Haematology & Transfusion Science
> Human Physiology
> Immunology
> Medical Biochemistry
> Microbiology**
**Not available via distance learning.

Professional accreditation

All modules are accredited by the Institute of Biomedical
Science (IBMS).

Why choose this course?

Modules accredited by the Institute of
Biomedical Science. Study on campus or via
distance learning. Ideal for those who wish to
register as a Biomedical Scientist but currently
hold a non-accredited degree. Top 25 in the UK
for Biological Sciences (Sunday Times University
Guide, 2019).

Entry requirements

A non-accredited undergraduate degree in
Biomedical Science or a related field such as
biology or biochemistry. Before applying to
study any of these top up modules students will
need to contact the IBMS to have their current
non-accredited degree assessed for eligibility to
‘top-up’ and for confirmation on which modules
will be required.

Career prospects

Top-up modules offer you the opportunity to
enhance your knowledge and skills in order to
develop your career. These modules will allow
you to obtain the academic competences that
are required to apply to the Health and Care
Professions Council (HCPC) for Registration as a
Biomedical Scientist.

Overview

Research environment

By studying a postgraduate research qualification at
Aston you will become part of an exciting and vibrant
research environment, one that will enable you to work
alongside leaders in their field, and engage in various
events and seminars. You will also have the opportunity
to join our dedicated research society which organises
a range of social and academic events.
Entry requirements

UK equivalent of a First or Upper Second Class
Honours degree in a relevant subject, or have an
MSc and/or similar award or experience deemed
to provide evidence of research potential. Nonnative English language speakers will need to
meet minimum English language requirements.

Find out more
Full details of all of our postgraduate research
opportunities including entry requirements, fees and
funding at www.aston.ac.uk/lhsphd

Continuing Professional
Development
We offer a range of flexible professional learning
opportunities for those looking to develop
their career and enhance their knowledge and
skills. Our qualifications are recognised by the
professions / industry and are regularly reviewed
by relevant professional experts. Many are also
accredited by appropriate professional bodies.
Short Courses - varying from skills workshops
to blended learning programmes involving
distance learning, these courses are non-credit
bearing.

Graduate Diploma - an undergraduate level
qualification for those that have already obtained
a degree.
Professional Accreditation - courses
delivered by Aston University to prepare you
for professional examinations, such as those
required to join the GOC Therapeutics Register
for Independent Prescribing.
Postgraduate Certificate - known as
a PgCert, this is a 60 credit masters level
qualification.
Postgraduate Diploma - known as a PgDip,
this is a 120 credit masters level qualification.
Master of Science – known as an MSc, this is
a 180 credit masters level qualification, typically
involving a research project or dissertation.
Professional Doctorate - this substantial
course will enable you to be at the forefront of
your academic discipline through taught and
research elements.

Subject areas

> Audiology
> Biomedical Sciences
>	Neurophysiology and Neurosensory Sciences
>	Optometry
>	Pharmacy and Pharmaceutical Science
>	Psychology
Find out more

Find full details including course listings, entry
requirements and fees at www.aston.ac.uk/lhscpd
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School of
Languages
& Social Sciences

For full details of entry
requirements for each course
please visit the course page
on our website:
www.aston.ac.uk/lss

The School of Languages
and Social Sciences is one of
only a handful of academic
units in the UK to span both
the Humanities and Social
Sciences. In doing so, it
draws on a particularly rich
and distinguished tradition
of teaching, scholarship and
research.

Since then, the School has grown
rapidly in student numbers and
in its academic coverage and
now comprises four academic
departments: English, Languages
and Translation Studies, Politics
and International Relations as well
as Sociology and Policy.

During the 1970s and 1980s,
the Department of Modern
Languages (French, German,
Linguistics), as it was then known,
was one of the UK’s pioneers
of the study of language in
contemporary society. In 1995,
reflecting the growing interest
in and awareness of Europe, it
became the School of Languages
and European Studies. In 2004,
we adopted our current title.
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T

+44 (0)121 204 4910

E

Our distinctive combination
of subjects gives a unique
perspective on language and
society, both in their own context
and in relation to each other.
The School of Languages and
Social Sciences is a closely
integrated, innovative, multilingual
and multidisciplinary School with
an international outlook. Our
degree programmes combine a
rigorous disciplinary grounding
with a cross-disciplinary, practical
and issue-focused perspective.

ask@aston.ac.uk

W

www.aston.ac.uk/lss

Quality
The School of Languages and
Social Science has 100% of
its REF submission for Modern
Languages and Linguistics
rated at 4* or 3* for research
environment, ranking Aston
joint 1st in the UK. Our belief is
that research should always be
practical, relevant and feedback
into your education. By always
focusing on the latest and most
impactful research, we produce
fresh and industry informed
curricula that prepare you for the
job market.
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Double MA in Europe and
the World
Studying at Aston University and Sciences Po Lille

Programme overview

Develop skills in critical analysis of contemporary
European integration, in both English and French.
Further your practical skills in European issues
through an EU-focused internship during the
second year of study. An innovative, 2-year Masters
programme taught in Birmingham and in Lille,
which offers students an internationally-oriented
understanding of European and international affairs.

Core modules

>	The European Union – A Web of Institutions
>	The EU as a Global Actor
>	Dissertation Module

Elective modules

>	Leaders and Leadership in a European and Global
Context
>	Europe’s Regions and their Governance
>	Europe and East Asia Religion and Politics
>	Corruption & Crime- Terror Nexus: Defense
>	International Political Communication
>	Rogue States
>	Governance of Global Problems
>	Critical Approaches to Security Studies
>	International Political Economy
>	EU Law and Policy Making
>	EuroSim: Learning Negotiation Through Simulations
>	Interest Groups and Lobbying in the European
Context
>	Corruption & Crime-Terror Nexus: Internal Security
>	Post-Migration Europe
Why choose this course?

Offering a unique, international perspective
on Europe’s role in global perspective, this
course also gives students the experience of
living and studying in two different countries,
with the opportunities for personal growth this
entails. Modules are relevant and contemporary,
exploring today’s political situations. You will also
become an active member of the Aston Centre
for Europe - a thriving research hub which
organises debates, study visits, conferences and
seminars on current international issues.

Career prospects

Gain the knowledge, analytical and transferable
skills to pursue further postgraduate research
or a successful career in the public and private
sector. Typical careers include: employment
in international organisations (EU, WTO, UN
etc), research in policy-oriented domestic or
international think tanks, careers in government
administration, further postgraduate research at
PhD level journalism and international marketing
or business.
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Joint MA in Multilevel
Governance and
International Relations

With integrated professional training
Studying at Aston University and Sciences Po Rennes

Programme overview

You will develop an excellent understanding of
multilevel governance and international relations
by studying at Aston University and at Sciences
Po, in Rennes (L’Institut d’Etudes Politiques). This
programme will challenge you to engage fully with
study opportunities in both learning institutions,
developing life-long skills and open up new
professional opportunities. You will also have the
opportunity to undertake a related internship.

Core modules

The modules on offer, and the content of the modules
is subject to change.
> International Relations Theory
> Governance of Global Problems

Elective modules

>	Research Methods
>	Leaders and Leadership in a European and Global
Context
>	Europe’s Regions and their Governance
>	Asia-Europe Relations: between Inter-regionalism
and Bilateralism
>	Religion and Politics
>	Security and Defence in Europe
>	International Political Communication
>	International Ethics and Literature
>	Transatlantic Relations in Historical Perspective:
The US and Europe
> International Security
> Comparative and International Political Economy
Why choose this course?

This course gives students the experience of
living and studying in two different countries,
with the opportunities for personal growth this
entails. Modules are relevant and contemporary,
exploring today’s political situations. You will
also become an active member of the Aston
Centre for Europe - a thriving research hub which
organises debates, study visits, conferences and
seminars on current international issues.

Career prospects

Pursue further postgraduate research, or a
successful career in the public and private
sector. Typical careers include: employment
in international organisations (EU, WTO, UN
etc), Research in policy-oriented domestic or
international think tanks, careers in government
administration, further postgraduate research at
PhD level, journalism and international marketing
or business.

MA in the European
Union and International
Relations

Joint MA in Conflict and
Security

Programme overview

Programme overview

You will broaden your global perspectives on issues of
governance and contemporary international relations,
and develop wide-ranging skills of critical analysis
and approaches to the study of European integration
and international relations. You will study at a leading
centre for research on contemporary Europe and
international relations, and forge a career working for
international organisations, governments and global
political institutions.

Core modules

The modules on offer, and the content of the
modules, is subject to change.
>	The EU as a Global Actor
> Concepts and strategies for Social Science

Elective modules

>	Leaders and Leadership in a European and Global
Context
>	Europe’s Regions and their Governance
>	Europe and East-Asia
>	Religion and Politics
>	Corruption & Crime-Terror Nexus: Defense
>	Rogue States
>	EuroSim: Learning Negotiation Through
Simulations
>	EU Law and Policy-Making
>	Rethinking European Integration
>	Corruption & Crime-Terror Nexus: Internal Security
>	Post-Migration Europe
>	Conflict, Security and Development
>	Freedom versus Security? Justice and Home
Affairs in Europe
>	Changing China: People’s Republic in the 21st
Century

Studying at Aston University and Metropolitan University
of Prague

This one-year Master’s Degree offers students
an exceptional opportunity to pursue a graduate
programme with a focus on conflict and security.
You will gain a comprehensive overview of multilevel
governance and international relations related to
conflict and security, taking into account British
and Czech perspectives. Students spend the first
semester at Aston University, where they study a
number of core and optional modules. The second
term takes place at Metropolitan University Prague,
where they study additional modules and complete a
final dissertation. All modules are taught in English.

Core modules

> Critical Approaches to Security Studies
>	Concepts and Strategies for Qualitative Social
Science

Elective modules

> International Relations Theory
> Religion and Politics
> Corruption and Crime-Terror Nexus: Defense
> Rogue States
> Governance of Global Problems
> Politics in South Europe
>	Human Security, Peacekeeping and Peacebuilding
>	Conflicts and Conflict Resolution
>	Conflicts in Central, Eastern Europe and PostSoviet States
>	Actorness and Power in Global Security
>	Contemporary Analysis of East Asian Security
Why choose this course?

Our modules are relevant and contemporary,
exploring today’s political situations. You will also
become an active member of the Aston Centre
for Europe - a thriving research hub which
organises debates, study visits, conferences and
seminars on current international issues.

Offering a unique, international perspective
on conflict and security, this course also gives
students the experience of living and studying in
two different countries, with the opportunities for
personal growth this entails. Modules are relevant
and contemporary, exploring today’s political
situations. You will also become an active member
of the Aston Centre for Europe - a thriving research
hub which organises debates, study visits,
conferences and seminars on current international
issues.

Career prospects

Career prospects

Why choose this course?

Gain the skills to pursue further postgraduate
research or a successful career in the public and
private sectors. Careers pursued by our students
include: international organisations (EU, WTO,
UN etc.), research in domestic or international
think tanks, careers in government, journalism,
international marketing or business.

Gain the knowledge, analytical and transferable
skills to pursue further postgraduate research or a
successful career in the public and private sector.
Typical careers include: employment in international
organisations (EU, WTO, UN etc), research in
policy-oriented domestic or international think
tanks, careers in government administration, further
postgraduate research at PhD level, journalism and
international marketing or business.
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MA in International
Relations and Global
Governance

Double Masters in
Governance and
International Politics

Studying at Aston University and Otto-FriedrichUniversität, Bamberg

Programme overview

This programme is ideally suited to internationally
oriented careers in the public or private sector.
Through this programme, graduates gain a high-level
understanding of political and economic power in a
globalised world. Studying modules on topics such
as Religion and Global Politics, Security and Defence
in Europe and International Political Communication
and Leaders, students develop wide-ranging insights
into political behaviour and skills in the critical analysis
of contemporary political issues. This programme is
ideally suited to internationally oriented careers in the
public or private sector.

Programme overview

You will develop a deep understanding of issues of
contemporary research in the field of governance
and international politics, whilst benefitting from
the combined expertise of teaching staff in two
institutions: first year at Aston University, second year
at Bamberg University. Gain skills in critical analysis of
contemporary European integration, in both English
and German language.

Core modules

>	International Relations Theory
> Governance of Global Problems

Core modules

> International Relations Theory
> Governance of Global Problems

Elective modules

> The EU: A Web of Institutions
> The EU as a Global Actor
> Europe’s Regions and Their Governance
> Critical Approaches to Security Studies
> Europe and East Asia
>	Leaders and Leadership in the European and
Global Context
> Religion and Politics
> Corruption and Crime-Terror Nexus: Defense
> International Political Communication
>	EuroSim: Learning Negotiation Through
Simulations
> International Political Economy

Elective modules

>	The EU: A Web of Institutions
>	Critical Approaches to Security Studies
>	Europe and East Asia
>	Leaders and Leadership in the European and
Global Context
>	Religion and Politics
>	Corruption and Crime-Terror Nexus: Defense
>	International Political Communication
>	EuroSim: Learning Negotiation Through Simulations
>	International Political Economy
>	Rethinking European Integration
>	Corruption & Crime-Terror Nexus: Internal Security
>	Transforming African Politics
>	Conflict, Security and Development
>	Freedom versus Security? Justice and Home
Affairs in Europe
>	Changing China: People’s Republic in the 21st
Century
Why choose this course?

Enjoy active membership of the Aston Centre
for Europe, -a thriving research hub which
organises debates, study visits, conferences and
seminars on current international issues - and
have the opportunity to take part in a week long
study trip to visit the EU institutions and related
organisation in Brussels.

Career prospects

Gain the skills to pursue further postgraduate
research or a successful career in the public and
private sectors. Careers pursued by our students
include: international organisations (EU, WTO,
UN etc.), research in domestic or international
think tanks, careers in government, journalism,
international marketing or business.
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Marion Greziller
Course

Double MA Europe And the World

Aston has given me an introduction to the
world of research and academia and the
tools to apply and obtain a scholarship to
pursue a PhD.”

Why choose this course?

Offering a unique, international perspective on
the concept of governance, this course also
gives students the experience of living and
studying in two different countries, with the
opportunities for personal growth this entails.
Modules are relevant and contemporary,
exploring today’s political situations. You will
also become an active member of the Aston
Centre for Europe - a thriving research hub - and
have the opportunity to take part in a week-long
study trip to visit the EU institutions and related
organisations in Brussels.

MA Forensic Linguistics
Programme overview

This programme provides a thorough grounding in
the broad spectrum of forensic linguistics. We see
the discipline as including the study of the language
of the law, providing investigative assistance and
then possibly evidence to the Courts, and also
incorporating knowledge of the sister discipline of
forensic speech science. Students will therefore learn
about legal and forensic contexts, about linguistic
insights and methods of analysis and about how the
two can be brought together in the application of
language description to these contexts. Strong links
with police and other end users and the fact that the
teaching staff includes practitioner forensic linguists,
give you unique access to real world data for student
learning and research work.

Core modules

>	Linguistics in legal contexts
>	Analysing written and spoken discourse
>	Research methods for forensic linguistics
>	Language as evidence
>	Forensic speech science
>	Practical applications in forensic linguistics
>	Dissertation
Why choose this course?
Choose this course if you are interested in
how the analysis of language can assist in the
delivery of justice.
Career prospects
While there is no well-trodden professional
route for forensic linguists, past students have
moved on to jobs with the police and security
services, and into careers in research. The
course is also an excellent foundation for
studies at PhD level.

Career prospects

Gain the knowledge, analytical and transferable
skills to pursue further postgraduate research
or a successful career in the public and private
sector. The careers pursued by our students vary
greatly, but typical careers include: employment
in international organisations (EU, WTO, UN
etc), research in policy-oriented domestic or
international think tanks, careers in government
administration, further postgraduate research at
PhD level, journalism and international marketing
or business.
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MA in Teaching English
to Speakers of Other
Languages (TESOL)
Programme overview

Designed for those who would like to obtain a
substantial postgraduate qualification in the field of
TESOL, you will have the opportunity for in-depth
investigations into language pedagogy and theory of
language use. Suitable for experienced teachers as
well as those with little classroom experience, this
programme helps you make informed decisions on
different aspects of TESOL.

Core modules

>	Theory and Practice of English Language
Teaching
>	Language Awareness
>	Research Methods
>	English Teaching Practice * (core if less than
2 years’ teaching experience; option for more
experienced teachers)

Elective modules

>	Analysing Discourse
>	Teaching Young Learners
>	Course and Materials Design
>	Language Contact and Multilingualism
>	Language and Literature in Education
>	Research Topics in TESOL
>	Technology in Teaching and Learning
>	Communicating across Cultures
(Please note that not all options will be offered every
year)

Professional accreditation

Credits may be awarded if you have the DELTA
diploma.

MA in TESOL and
Translation Studies
Programme overview

You will acquire additional expertise in translation
theory and skills to pursue a career in TESOL. The
course is designed for those who have little or no
teaching experience, and builds on our extensive
experience and highly successful distance learning
Masters programmes in TESOL.

Core modules

>	Theory and Practice of English Language Teaching
>	The Translation Industry: Theoretical and Practical
Perspectives I
>	Translation Technology I: CAT Tools and Localisation
>	Multilingual Specialised Translation

Elective modules

>	Language and Literature in Education
>	Language Contact and Multilingualism
>	English Teaching Practice
>	Teaching Young Learners
>	Technology in Teaching and Learning
>	The Translation Industry: Theoretical and Practical
Perspectives II
>	Translation Technology II: Machine Translation,
Post-editing, Audiovisual Translation
>	Business and Enterprise Skills for Translators
>	Translating for International Institutions
>	Specialised Translation: French/German/Spanish
<> English
>	Translation for Business: Arabic/Chinese/
Portuguese <> English

Professional accreditation

Aston is a corporate member of the Institute of
Translation and Interpreting (ITI).
Why choose this course?

Why choose this course?

The programme modules represent a balance
between pedagogy and linguistic theories,
with an emphasis on linking theory with
practical classroom application. Teaching
practice provides an introduction to all the
practical issues involved in TESOL, while also
offering opportunities to experiment with new
approaches and to develop your teaching skills
and professional expertise. The elective modules
and the dissertation enable you to specialise in
particular areas of interest.

Career prospects

The MA TESOL is a substantial qualification
which will enhance career options in the global
contexts of English language teaching, and
graduates of the programme are working as
TESOL teachers all over the world.
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Demand for translators and interpreters is
increasing rapidly, as organisations become
more globalised. You will learn the practical
and professional skills of translation and gain
real-world experience through our placement
module. Practising tranlsators and industry
representatives, and you will have the opportunity
to work towards Chartered Institute of Linguists’
and TRADOS certification. Demand for teachers
of English as a foreign language is also growing
every day, as English becomes more used
worldwide. By doing this Masters, you will obtain
a substantial postgraduate qualification in the
field of TESOL.

Career prospects

Graduates have gone on to work as translators,
technical editors and translation project
managers for translation companies and software
developers, both in the United Kingdom and
abroad. Graduates of the TESOL programmes
also work as teachers all over the world.

MA in Translating
for Business and
International Institutions
Programme overview

This innovative programme prepares you both for a
professional career in the global language industry
and for ongoing research. You will learn about the
business of translation from professionals working in
the industry and gain practical, hands-on, experience
through our placement module.

Core modules

>	The Translation Industry: Theoretical and Practical
Perspectives
>	Translation Technology I: CAT Tools and
Localisation
>	Multilingual Specialised Translation
>	Business and Enterprise Skills for Translators
>	Dissertation
>	Practical translation modules
Practical translation modules:
>	Specialised Translation Practice: French – English
>	Specialised Translation Practice: German - English
>	Specialised Translation Practice: Spanish - English
>	Translation for Business: Arabic - English
>	Translation for Business: Chinese - English
>	Translation for Business: Portuguese - English

Elective modules

You can choose two of the following modules;
>	Translating for International Institutions
>	Translation Work Placement
>	Translation Technology II: Machine Translation,
Post-editing, Audiovisual Translation

Professional accreditation

Aston University is a corporate member of the
Institute of Translation and Interpreting (ITI)
Why choose this course?

Demand for translators and interpreters is
increasing rapidly, as organisations become more
globalised. Apart from developing your translation
skills, this programme equips you to fully integrate
into the vibrant international translation market. It
allows you to gain real-world experience through
our placement module. You will also benefit
from guest lectures from practising tranlsators
and industry representatives, and will have the
opportunity to work towards Chartered Institute of
Linguists’ and TRADOS certification.

Career prospects

Recent destinations for our graduates include
in-house or freelance translation, mainly working
for business, institutions and public service. Our
graduates also work as project managers for
translation agencies, technical editors and software
developers, both in the UK and abroad.

PhD
Programme overview

Our PhD programme is designed to train Doctoral
students who aspire to become future academics or
professional industry researchers.

Research strengths

Our research strengths are embedded in our
academic departments:
>	English
>	Languages (French, German, Spanish) and
Translation Studies
>	European integration in comparative political,
security, social and economic context
>	International Relations
>	Politics
>	Sociology & Policy
You are strongly recommended to explore these
before applying.

Programme content (including any
research methods courses)

During year one of the programme (or years one and
two for part time students) research students must
complete our ESRC-accredited research methods
training modules and work towards submission of the
Qualifying Report examination. The Qualifying Report is
between 6,000 and 10,000 words and is a summary
on the progress of a student’s research. Assessment
is conducted through a viva voce examination whose
purpose is not only to ascertain a student’s academic
potential but also to provide independent advice on a
student’s research. Students who are successful in the
Qualifying Report examination then follow the full PhD
programme route through to submission of the final
thesis. PhD students have three years full time or six
years part time from their research start date in which to
submit the thesis.

Research environment

We have an exciting and vibrant research environment
that enables you to engage in various research events
and seminars. There is also a dedicated research
society which organises social and academic events.
Entry requirements

>	A Masters degree or an equivalent
qualification. A minimum of an overall merit
grade (or equivalent), with merit in the
dissertation is normally required.
>	IELTS: 6.5 (minimum 6.5 in writing and
reading and minimum 6.0 in speaking and
listening)
>	TOEFL iBT: 93 (minimum 26 in writing, 22 in
speaking, 19 in listening, 18 in reading)
>	Pearson Academic: 63 (minimum 63 in writing
and speaking, and 57 in reading and listening)
>	Cambridge Certificate of Proficiency in English
(CPE): Grade B
>	Cambridge Certificate in Advanced English
(CAE): Grade A
Languages & Social Sciences

67

MAKE YOUR MOVE
AND CHOOSE THE
ASTON MASTERS
Applying is easy, just
follow our five step guide

1

Choose your
Masters
By the time you have got to this page, chances are
you are pretty sure which course is right for you. If
not, flick back through the brochure or browse our
website www.aston.ac.uk for some inspiration.
Don’t forget, our Admissions Team are on hand to
answer any questions you might have and advise you on
which course is most suitable for you.

2

Complete your
application
After checking
that you meet our
entry requirements,
complete the simple
online application
form which can be
found from your
chosen course page.

3

We assess your
application

4

We’ll take a look over
your application to
make sure that you
are suitable for the
course. Don’t worry,
if we have any further
questions, we will
send you an email.

GET IN
TOUCH
If you need any advice
or have a question about
the application process,
contact the Admissions
Team by emailing ask@
aston.ac.uk or phone
+44 (0)121 204 4910.
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We’ll be in
touch
We’ll let you know
whether your
application has been
successful. If we
offer you a place,
you will receive either
a conditional or
unconditional offer.

CHECK
YOUR EMAILS
All contact will be made
over email, so make
sure that the email
address you use on your
application in the one that
you use and check on a
regular basis

5

Accept your
place
You need to let us
know that you are
accepting your offer.
All you need to do is
follow the link in your
offer email to send
us your acceptance
documents and
pay your deposit as
outlined in your offer
email.

SEE FOR
YOURSELF
We hold regular events
to give you a chance
to visit campus as part
of an open event, meet
our staff at fairs around
the world, or through
webinars and webchats
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A-Z

Index of
programmes
Accounting and Finance
Artificial Intelligence*
Biomedical Science
Business Analytics
Business Economics and Finance
Business and Management
Business and Management Online
Business Psychology
Cognitive Neuroscience
Communication Systems and Wireless Networking
Computer Science
Conflict and Security
Continuing Professional Development
Drug Delivery
Engineering Management
Entrepreneurship
Enterprise Development
Executive DBA
European Union and International Relations
Europe and the World
Finance
Forensic Linguistics
Global Operations and Service Management
Governance and International Politics
Health Psychology
Human Resource Management
Information Systems and Business Analysis
International Accounting and Finance
International Accounting and Finance Online
International Business
International Pre-Masters
International Commercial Law
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34
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International Relations and Global Governance
Investment Analysis
Mechanical Engineering
Multilevel Governance and International Relations
MSc by Research
Optometry/ Ophthalmic Science
Overseas Pharmacists (OSPAP)
PhD Aston Business School
PhD School of Engineering & Applied Science
PhD School of Languages & Social Sciences
PhD School of Life & Health Sciences
Product Design
Pharmaceutical Sciences
Pharmacokinetics
Photonic Integrated Circuits, Sensors and
Networks (PIXNET)
Regenerative Medicines Manufacturing*
Research Degrees
Smart Telecom and Sensing Networks
(SMARNET)
Stem Cells and Regenerative Medicine
Strategy and International Business
Strategic Marketing Management
Supply Chain Management
Teaching English to Speakers of Other
Languages (TESOL)
TESOL and Translation Studies
The Aston MBA
Translating for Business and International
Institutions
Work Psychology and Business

The information contained in this Prospectus is relevant for applications to postgraduate programmes in the
academic session September 2019 - June 2020. Whilst information in this prospectus is correct at the time
of going to press (October 2018), Aston University does not guarantee its accuracy or completeness and
information in this Prospectus may differ from information that is issued to applicants as part of an offer.
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FOR YOUR
FUTURE
THE ASTON
MASTERS
aston.ac.uk /masters
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